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 Preface 

Preface 
This guide introduces you to QuickBooks – Intuit’s easy-to-use, powerful accounting system for small 

businesses.  

This guide is designed to teach you how to use many of the features available in QuickBooks Software 

for Windows Desktop. The main focus of this guide is on how to use the features in QuickBooks Premier 

and Accountant, but most exercises can be completed using QuickBooks Pro. This guide does not cover 

how to use the features in QuickBooks Online or QuickBooks Pro for Mac. 

While this guide does not specifically address how to use QuickBooks Enterprise Solutions, many of the 

procedures described in the guide will work with Enterprise Solutions editions. If you restore the exercise 

file using a QuickBooks Enterprise Solutions product, QuickBooks walks you through the file update 

process that is necessary for Enterprise Solutions to be able to read the file. 

QuickBooks 2021 Version 

This textbook will guide you through learning QuickBooks 2021 and comes with a Student Trial.  

Using the QuickBooks 2021 Student Trial  

QuickBooks Accountant 2021 Student Trial is a full-featured version of QuickBooks that is included with 

this guide. You can install it on your computer and use it to complete the exercises in this guide and to 

practice using QuickBooks.  

QuickBooks Accountant can “toggle” to other versions of QuickBooks, including QuickBooks Premier, 

Pro, and Industry editions. The trial software can be used to explore any of these versions of 

QuickBooks. 

To install QuickBooks Accountant 2021, follow the directions on the card at the back of this book. 

You can use this product for 5 months after installation. 

Using This Book 

Throughout this book, you will find tips on how to set up and use QuickBooks so that you and your 

company have the information you need to make business decisions. 

Each chapter covers how to manage a general part of your business. To allow you to learn the chapters 

in any order, each chapter uses a separate QuickBooks data file that you can use with QuickBooks to 

complete the practice lessons.  

Imagine Photography, Inc. is the model company used throughout the chapters. By performing the in-

chapter practices, students gain hands-on experience with the topics discussed in the chapter, which 

are based on the day-to-day operations of this small corporation. 

Each chapter is designed to aid understanding by providing an overview of topics, numerous hands-on 

tutorial practices, key terms, the “accounting behind the scenes,” and many extra notes. The illustrated 

text includes step-by-step instructions with hands-on computer exercises to provide you with practical 

experience.  

The end-of-chapter assessments include comprehension questions, multiple choice questions, 

completion sentences, and real-world problems that require the student to perform tasks with the 

software.  

The final two chapters of this book are case studies. They consist of summary problems covering topics 

culled from all the chapters in this book.  
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From using this book, you will gain confidence in every aspect of QuickBooks by trying out each feature 

as you complete problems and case studies of a “real” business. You will want to keep this book for 

reference for years to come. 

Integrating QuickBooks with other products 

If you plan to use the Microsoft Office integration features available in QuickBooks, such as exporting to 

Excel, you will need to have Microsoft® Office installed on your system.  

About the exercise files 

Exercise files are used with the chapters and problems throughout this book. For each chapter and 

problem in this guide, you’ll restore a copy of the exercise file named in the beginning of the section and 

use that file to complete the chapter and chapter problem. This means that at the start of each lesson, 

you will be restoring a new file. It is very important to be in the correct file to ensure that your screen will 

match the book’s screenshots. 

Installing the exercise files 

The exercise files for the chapters and problems are available at the following address: 

www.questivaconsultants.com/downloads/ 

To install the files on your hard drive, follow these steps: 

Step 1. Go to www.questivaconsultants.com/downloads/ 

Step 2. Find this book’s title and click the link. You will be taken to the support page for this book.  

Step 3. Click the Product Support Download tab and click the link to download 

QuickBooks_2021_Classroom_Files.zip. Save the files to the desired location on your 

local system. If you are using a computer in a classroom or lab environment, ask your 

instructor for the proper location to store your exercise files. 

Step 4. Once you have saved the file to the proper location, you will need to “unzip” it. Select the 

zip file in Windows Explorer. You should see an option at the top of the window to Extract. 

Click the Extract option and choose Extract All.  

Important:  

The Classroom Files are in QuickBooks Portable File Format. You cannot open these files 

by double-clicking them. For more on how to begin using these files, see page 10. 

Instructor Resources 
Instructor resources, including the Instructor’s Manual, test banks, solution files, and PowerPoints are 

available at www.questivaconsultants.com/downloads. You must be a verified instructor with an 

accredited school to access these files. If you do not already have an instructor login, please contact 

info@questivaconsultants.com.  

Restoring exercise files 
Each chapter uses a separate practice file (e.g., Intro-21.QBW) for performing the in-chapter practices. In 

order to open this file, you must “restore” it as described in the first chapter (see page 10).  

In the beginning of each chapter, the Restore This File instruction (see example below) instructs you to 

restore the practice file for that chapter to use with the computer practice lessons. 

Example Restore this file instruction: 
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Restore this File: 

This chapter uses XXXXX-21.QBW. See page 10 for more information. 

The exercises are identified throughout the book with the words COMPUTER PRACTICE. 

Certification 

This book is excellent preparation for the Certiport QuickBooks User Certification Exam. This certification 

validates your QuickBooks knowledge. After successfully completing the exam, you will become an Intuit 

QuickBooks Certified User. For more information and for locations of testing centers, visit 

http://www.certiport.com/quickbooks. 
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Chapter 1  

Introducing QuickBooks 

Topics 

In this chapter, you will learn about the following topics:  

• The QuickBooks Product Line (page 1) 

• Accounting 101 (page 2) 

• QuickBooks Files (page 5) 

• Opening Portable Company Files (page 10) 

• Restoring Backup Files (page 14) 

• QuickBooks User Interface Features (page 19) 

• Entering Transactions in QuickBooks (page 22) 

• QuickBooks Help (page 27) 

QuickBooks is one of the most powerful tools you will use in managing your business. QuickBooks isn’t 

just a robust bookkeeping program; QuickBooks is a management tool. When set up and used 

properly, QuickBooks allows you to track and manage income, expenses, bank accounts, receivables, 

inventory, job costs, fixed assets, payables, loans, payroll, billable time, and equity in your company. It 

also provides you with detailed reports that are essential to making good business decisions.  

QuickBooks helps small business owners run their businesses efficiently without worrying about the 

debits and credits of accounting entries. However, to use QuickBooks effectively, you still need to 

understand how QuickBooks is structured, how its files work, how to navigate in the system to do 

tasks, and how to retrieve information about your business. In this chapter you’ll learn some of the 

basics of the QuickBooks program and then you will explore the world of accounting.  

The QuickBooks Product Line 

The QuickBooks family of products is designed to be easy to use, while providing a comprehensive set 

of accounting tools including: general ledger, inventory, accounts receivable, accounts payable, sales 

tax, and financial reporting. In addition, a variety of optional, fee-based payroll services, merchant 

account services, and other add-on products integrate with the QuickBooks software.  

QuickBooks Desktop vs. QuickBooks Online 

Intuit offers two distinctly different ways to use QuickBooks. One version is installed on your local 

computer and is referred to as QuickBooks Desktop. The other is QuickBooks Online, a cloud-based 

application that isn’t installed on your computer, but is accessed online through a web browser or app 

on a smartphone or tablet. The online edition has different, yet similar, features to QuickBooks 

Desktop. This textbook covers QuickBooks Desktop.  

QuickBooks Versions 

The QuickBooks Desktop product line includes several separate product editions: QuickBooks Pro, 

QuickBooks Premier, QuickBooks Accountant, and QuickBooks Enterprise. The Premier and Enterprise 
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versions are further broken down into six industry-specific versions for General Business, General 

Contractor, Manufacturing & Wholesale, Nonprofit, Professional Services, and Retail.  

This book covers the features and usage of QuickBooks Pro, Premier (non-industry specific), since 

most small businesses will use one of these editions. We will also occasionally refer to the Accountant 

edition, which has additional tools for bookkeepers. Once you learn how to use one of these versions, 

you’ll be prepared to use any of the others.  

All editions of QuickBooks support multiple users; however, each user must have the same version of 

QuickBooks to access the file. Multi-user files must be shared on a dedicated server or be hosted by a 

remote service. 

QuickBooks Pro and Premier are sold as either as a one-time purchase, or through a PLUS 

subscription. The benefits to subscribing include enhanced customer support, an online backup 

service, automatic upgrades from version to version, and exclusive features such as Receipt 

Management, which allows users to photograph receipts with their mobile devices. 

For a comparison of all products and options, visit www.quickbooks.com. 

Accounting 101 

Having a basic background in the accounting process will help you learn QuickBooks and run your 

business. In this section, we look at some basic accounting concepts and how they relate to 

QuickBooks.  

Accounting’s Focus 

Accounting’s primary concern is the accurate recording and categorizing of transactions so that you 

can produce reports that accurately portray the financial health of your organization. Put another way, 

accounting’s focus is on whether your organization is succeeding and how well it is succeeding.  

The purpose of accounting is to serve management, investors, creditors, and government agencies. 

Accounting reports allow any of these groups to assess the financial position of the organization 

relative to its debts (liabilities), its capabilities to satisfy those debts and continue operations (assets), 

and the difference between them (net worth or equity).  

The fundamental equation (called the Accounting Equation) that governs all accounting is: 

Assets = Liabilities + Equity, or Equity = Assets - Liabilities. 

The General Ledger 

Many factors go into making an organization work. Money and value are attached to everything that is 

associated with operating a company — cash, equipment, rent, utilities, wages, raw materials, 

merchandise, and so on. For an organization to understand its financial position, business 

transactions need to be recorded, summarized, balanced, and presented in reports according to the 

rules of accounting. 

Business transactions (e.g., sales, purchases, operating expense payments) are recorded in several 

types of ledgers, called accounts. The summary of all transactions in all ledgers for a company is called 

the General Ledger. A listing of every account in the General Ledger is called the Chart of Accounts.  

Each account summarizes transactions that increase or decrease the equity in your organization. The 

figure below shows a general picture of the effect your accounts have on the equity of your 

organization. Some accounts (those on the left) increase equity when they are increased, while others 

(those on the right) decrease equity when they are increased. 
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So, let’s return to the accounting equation. To understand the accounting equation, consider the 

following statement: Everything a company owns was purchased by funds from lenders, or the owner’s 

stake in the company. 

Account Types and Financial Reports 

Each account in the general ledger has a type, which describes what kind of business transaction is 

stored in that account. There are primarily five types of accounts: asset, liability, equity, income, and 

expense. Assets, liabilities, and equity accounts are associated with the Balance Sheet report, which is 

used to analyze the net worth of a business. The income and expense accounts are associated with 

the Profit & Loss report (also called an Income Statement), which is used to analyze the operating 

profit or loss for a business over a specific time range (month, quarter, year, etc.). 

The Balance Sheet report preserves the fundamental accounting equation - Total assets always equal 

the total liabilities plus equity, between the accounts. This means that the total of the assets (which 

represent what the company “owns”) is always equal to the sum of the liabilities (representing what 

the company owes) plus the equity (representing the owner’s interest in the company). Although 

income and expense accounts are not directly shown in the accounting equation, they do affect this 

equation via the equity account as shown below. 

The income and expenses are tracked throughout the year, as business transactions occur, and are 

totaled at the end of the year to calculate Net Income (or Loss). Net income (total revenues minus total 

expenses) increases the owner’s equity in the business, and net loss (when expenses exceed 

revenues) decreases the owner’s equity in the business. Thus, the Income and Expense accounts 

indirectly affect the Equity component of the accounting equation of Assets = Liabilities + Equity, 

where Equity increases or decreases each year depending on whether the year’s income exceeds 

expenses or not.  

At the end of the year, the balance of each income and expense account is reset to zero so these 

accounts can track the next year’s transactions.  

Double-Entry Accounting 

Double-entry accounting is the technique that makes the accounting equation work. It divides each 

account into two sides. One side is a record of transactions that increase the account, and the other 

side is a record of all transactions that decrease the account. One side (the left side) is for debits, and 

the other (the right side) is for credits. Depending on the type of account, a debit might increase the 

account or decrease it. The same is true of credits. Therefore, debits are not always bad, and credits 

are not always good. They are just part of the system of accounting. However, the rule of double-entry 

accounting is that total debits must always equal total credits. Every transaction creates a debit in one 

or more accounts and a credit in one or more accounts. If the debits and credits for any transaction 

are not equal, the transaction has an error or is incomplete.  
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Accounting Behind the Scenes 

Recording and categorizing all of your business transactions into the proper accounts, summarizing 

and adjusting them, and then preparing financial statements can be an enormous, labor-intensive task 

without the help of a computer and software. This is where QuickBooks comes in. QuickBooks focuses 

on ease of use and hiding accounting details. To make all this possible, QuickBooks uses components 

like accounts, items, forms, registers, and lists, which are discussed later in the chapter. Familiar-

looking forms such as invoices, checks, and bills are used for data entry. As you enter data in forms, 

QuickBooks handles the accounting entries for you. Thus, business owners can use QuickBooks to 

efficiently run a business without getting bogged down with the debits and credits of accounting 

entries.  

QuickBooks also handles double entry for you. Every transaction you enter in the program 

automatically becomes a debit to one or more accounts and a credit to one or more other accounts. 

QuickBooks won’t let you record the transaction until the total of the debits equals the total of the 

credits. This means you can create reports that show the transactions in the full double-entry 

accounting format whenever you need them, allowing you to focus on the business transaction rather 

than the debits and credits in the General Ledger. 

Cash or accrual method, as discussed in the next section, is handled in QuickBooks as a simple 

reporting option. You can create reports for either cash or accrual basis regardless of the method you 

use for taxes.  

As the book introduces new transaction types (e.g., Invoices, Bills, or Checks), the text will include a 

section called “The Accounting Behind the Scenes.” For example, when you first learn about invoices 

you will see the following message: 

The Accounting Behind the Scenes:  

When you create an Invoice, QuickBooks increases (with a debit) Accounts Receivable 

and increases (with a credit) the appropriate Income account. If applicable, Invoices 

and Sales Receipts also increase (with a credit) the sales tax liability account. 

Letting QuickBooks handle the accounting behind the scenes means you can focus on your 

organization and identify the important factors that will help you succeed. Once you identify these 

factors, you can use QuickBooks to monitor them and provide information that will guide you in 

managing your operations. 

Accounting Basis: Cash or Accrual? 

Another critical aspect of accounting is managing for the future. Many times, your organization will 

have assets and liabilities that represent money owed to the company, or owed to others by the 

company, but are not yet due. For example, you may have sold something to a customer and sent an 

invoice, but the payment has not been received. In this case, you have an outstanding receivable. 

Similarly, you may have a bill for insurance that is not yet due. In this case, you have an outstanding 

payable. 

An accounting system that uses the Accrual Basis method of accounting tracks these receivables and 

payables and uses them to evaluate a company’s financial position. The accrual basis method 

specifies that revenues and expenses are recognized in the period in which the transactions occur, 

rather than in the period in which cash changes hands. This helps you more accurately understand the 

true profitability of the business in each period. Assets, liabilities, income, and expenses are entered 

when you know about them, and they are used to identify what you need on hand to meet both current 

and known future obligations.  

In the Cash Basis method, revenues and expenses are not recognized until cash changes hands. So, 

revenue is recognized when the customer pays, and an expense is recognized when you pay the bill for 

the expense.  
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Although certain types of companies can use the cash basis method of accounting, the accrual 

method provides the most accurate picture for managing your business. Some organizations are not 

allowed to operate as cash basis under IRS regulations. You should check with your tax accountant to 

determine which accounting method — cash or accrual — is best for you. 

In QuickBooks, you can record transactions such as invoices and bills to facilitate accrual basis 

reporting, and still create cash basis reports that remove the receivables and payables. This gives you 

the flexibility of selecting one basis for taxes and another for operational reporting, if you wish. For 

more information, see page 214. 

 

Imagine Photography Business Scenario 

Throughout this book, you will see references to a fictitious company called Imagine Photography. 

Imagine Photography is a photography studio that also sells camera equipment. This company uses 

QuickBooks for its accounting and business management. Imagine Photography may not be exactly 

like your business; however, the examples in this text that focus on Imagine Photography are generic 

enough to guide you on your own use of QuickBooks.  

Imagine Photography has two locations, one in San Jose and another in Walnut Creek. In order for 

management to separately track revenue and expenses for each store, Imagine Photography uses 

Classes in QuickBooks. As you proceed through the book, you’ll see how each transaction (bill, check, 

invoice, etc.) is tagged with what class it belongs to, so that later you can create reports like the Profit 

& Loss by Class. Classes can be used to separately track departments, profit centers, store locations, 

or funds in any business. 

Imagine Photography also needs to separately track revenue and expenses for each job it performs. 

When a customer orders a photo shoot, Imagine Photography needs to track all of the revenue and 

expenses specifically related to that job so it can look back and see how profitable the job was. This 

concept is called Job Costing, and many different businesses need to track jobs in similar ways. 

As you think through the examples with Imagine Photography, ask yourself what parallels you see to 

your own organization. Certainly, areas such as salaries, supplies, equipment, and others will be 

appropriate for your setup, but the names and specifics of the accounts, items, lists, and forms will 

probably be different. 

QuickBooks Files 

Before using QuickBooks, it is important for you to understand how QuickBooks files are structured 

and used. QuickBooks has three primary types of files described below. All file types can be opened 

using the Open or Restore Company option from the File menu. 

1. Working Data Files – These files are used to enter transactions and create reports. These are 

also called the Company Files. (File Extension .QBW) 

2. Portable Company Files –These files are a compact version of the company data files and are 

used to transport the file between computers. These files should never be used to back up your 

QuickBooks data because they omit non-financial content such as logos and templates. 

Portable files must be “Restored” to a working data file to be used. (File Extension .QBM) 

3. Backup Files –These files are a compressed version of the company data files and are used as 

backup to safeguard the information. These files cannot be used directly within QuickBooks 

and must be “Restored” to working data file format. (File Extension .QBB) 

 

If you name your company file ABC, QuickBooks will store the working data file as “ABC.QBW.” When 

you back up your company file using the QuickBooks Backup function, QuickBooks will store your 

backup file with the name “ABC.QBB.” If you create a portable data file using the QuickBooks Portable 

file creation function, the portable file “ABC.QBM” will be created.  
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In addition to the Backup and Restore process, which moves the complete QuickBooks file between 

computers, QuickBooks also has a feature called the Accountant’s Copy. This feature enables an 

accounting professional to review and make corrections to a special copy of the client’s company file 

while the client continues to work. Then the client can merge the accountant’s changes back into the 

original file. See the QuickBooks Help Index for information on this feature. 

Important:  

Each file type has a specific purpose and should be used accordingly. Working data files 

are used to enter data and run reports, backup files are used to safeguard the data, 

and portable files are compressed files used to transport data between computers 

because smaller files transfer faster. 

Opening Recent Files 

When QuickBooks opens, you will either see the No Company Open window (see Figure 1-1) or you will 

be prompted to enter the password for the last working data file used.  

 

The No Company Open window displays when you are opening QuickBooks for the first time, or if you 

closed the working data file before exiting in your last session. By default, the last working data file 

used reopens automatically if you closed the QuickBooks program without closing the file.  

Double-click on a file to open it. 

 
 

 

 

 

 
  

Figure 1-1 No Company Open window 

Find a Company File 

Click the Find a Company File box to scan your computer for all QuickBooks files (see Figure 1-2). 

 
Figure 1-2 Find a Company File 
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Creating a New File 

There are four ways to create a new QuickBooks file: Express Start, Detailed Start, Company Based on 

an Existing Company, and Conversion from Other Accounting Software. Although it is possible to 

create a QuickBooks file relatively quickly using Express Start, we recommend utilizing a 12-Step 

process for creating a file to properly set up accounts and account balances. We have placed the 

chapter that explains file setup later in the book so you will be able to utilize knowledge gained in 

earlier chapters. You can learn more about file setup in our File Setup chapter starting on page 445.  

Opening a QuickBooks Sample File 

For learning purposes, QuickBooks provides sample data files that allow you to explore the program. 

To open a sample data file, follow these steps: 

COMPUTER PRACTICE 

 Launch the QuickBooks program by double-clicking the icon on your desktop or 

selecting it from the Windows Start menu.  

 If you don’t see the No Company Open window, close the file that opens, or cancel the 

password login box. 

 Click Open a Sample file button and select Sample product-based business from the 

list. The selected sample file will open with the QuickBooks Information screen (see 

Figure 1-3).  

  
Figure 1-3 Sample File Information Screen 

 Click OK to continue. 

 The sample file you selected will open. If you see the Accountant Center or the 

External Accountant message, close the window by clicking the X in the top right 

corner. You can uncheck the box that says Show window when opening a company file 

and close the window of the Accountant Center, or check Don’t show this again in the 

External Accountant window. 

Opening Other QuickBooks Data Files  

If you want to open a QuickBooks company file other than the sample data files, follow the steps 

below. We will not complete these steps now, but will use a restored portable file in the next section. 

1. Launch the QuickBooks program by double-clicking the icon on your desktop or selecting it from 

the Windows Start menu. When QuickBooks opens, it launches the data file you most recently 

had open when you last exited the program, unless you specifically closed the data file before 

exiting. 
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2. To open a different file, select the File menu and then choose Open or Restore Company (see 

Figure 1-4). You can also click the Open or restore an existing company button on the No 

Company Open window. 

 
Figure 1-4 File menu 

3. In the Open or Restore Company window, select Open a company file and click Next. 

 
Figure 1-5 Open or Restore Company 

4. Use the Look in: field to navigate to the folder on your hard disk where you store your 

QuickBooks file (see Figure 1-6). 

  
Figure 1-6 Selecting the folder where the QuickBooks files are stored 

5. Select the file from the list of QuickBooks files, then click Open. 
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Note: 

When you open a data file, depending on today’s date, you may see one or more 

“Alerts” for learning to process credit cards, pay taxes, or similar activities. Click Mark 

as Done when you see these alerts. 

Your company file opens, and you are ready to work with QuickBooks. 

Opening Multiple Files 

It is possible to open two company files at the same time if you are using QuickBooks Accountant or 

Enterprise. However, the activities that can be performed in the second file are very limited. We 

recommend that you use one file at a time by closing a file before opening or restoring a different file.  

Closing QuickBooks Files 

Close the company data file by selecting Close Company from the File menu (see Figure 1-7). Skip this 

step to open this data file automatically the next time you start the QuickBooks program. 

 
Figure 1-7 Close Company File option 

Closing the QuickBooks Program 

Just as with any other Windows program, you can close the QuickBooks program by clicking the Close 

button, which looks like an X, at the upper right hand corner of the QuickBooks window, or by selecting 

Exit from the File menu.  

The Exiting QuickBooks window appears to confirm that you want 

to exit the QuickBooks program, as opposed to closing a window 

in QuickBooks. You can disable this message by checking the box 

next to Do not display this message in the future (see Figure 1-9). 

  
Figure 1-9 Exiting QuickBooks window 

Figure 1-8 Closing QuickBooks and windows 
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QuickBooks Updates and Releases 

Occasionally, errors are found in the QuickBooks software after the product is released for sale. As 

errors are discovered, Intuit fixes the problem and provides program “patches” via the Internet. Each 

patch increases the Release Level of the QuickBooks application. To see what release level of the 

software you have, press Ctrl+1 (or F2) while QuickBooks is running. At the top of the window, you will 

see the QuickBooks product information including the release level. 

Figure 1-10 Product information window showing version and release 

This book is based on QuickBooks Accountant 2021 Release R4P. If you have a different release, you 

may see some slight differences compared to the screenshots in this book. 

To patch your software with the latest maintenance update, download it by selecting the Help menu 

and then choosing Update QuickBooks. Follow the instructions on these screens to download and 

install maintenance releases in QuickBooks via the Internet.  

Opening Portable Company Files 

Portable Company Files are compact company data files that can be easily transported. The exercise 

files that accompany this book are Portable Company Files. You will need to open these exercise files 

at the start of each chapter and each problem. 

Important: 

When you move a data file from one computer (computer A) to another (computer B), 

any data you enter on computer B will cause the file on the computer A to become 

obsolete. Take care to make sure you are always working in the most recent data file.  

COMPUTER PRACTICE 

To open portable files follow the steps below.  

 Select the Open or Restore Company option from the File menu. 

 QuickBooks displays the Open or Restore Company window (see Figure 1-11). Select 

Restore a portable file (.QBM) and click Next. 

 
Figure 1-11 Open or Restore Company window 
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 QuickBooks displays the Open Portable Company File window (see Figure 1-12). 

Navigate to the location of your exercise files. You may need to ask your instructor if 

you do not know this location. Once you are viewing the contents of the correct folder, 

select Intro-21.QBM and click Open. 

  
Figure 1-12 Open Portable Company File window 

 Next you will need to tell QuickBooks where to save the working file that will be created 

from the portable file (see Figure 1-13). Click Next in the Open or Restore Company 

window to continue. 

  
Figure 1-13 Open or Restore Company Location 

 The Save Company File as window displays (see Figure 1-14). Ask your instructor or 

choose a location to save the file. When you have navigated to the appropriate folder, 

click Save. 
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`   
Figure 1-14 Save Company File as window 

 The QuickBooks Desktop Login window opens (see Figure 1-15). The password to this 

and every exercise file in this book is Questiva21. The password is case sensitive, so 

make sure you capitalize the first letter Q in Questiva21. Enter Questiva21 in the 

Password field and click OK.  

 

 

 
Figure 1-15 QuickBooks Desktop Login window 

Note:  

Every QuickBooks file is required to have a complex password. It must be at least 7 

characters long and contain at least one uppercase letter and one number. Although we 

use the same password for all the exercise files in this textbook, we recommend that 

you use a different password for your own or your employer’s QuickBooks file. For more 

on passwords see page 482.  

 If asked to update your company file, click Yes. 

 If you see the QuickBooks Desktop Information window saying that the Portable 

company file has been successfully opened, click OK to continue.  

 Once the Intro-21.QBW company file finishes opening, you will see the Home page. 
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Creating Portable Company Files 

You can also create a Portable file using the following steps: 

COMPUTER PRACTICE 

 Select the Create Copy option from the File menu (see Figure 1-16). 

 
Figure 1-16 Create Copy  

 The Save Copy or Backup window displays. Select the Portable company file option 

and click Next.  

 
Figure 1-17 Save Copy or Backup window 

 The Save Portable Company File window appears. The default file name in the File 

name field is the same as the working file name with “(Portable)” added to the end. 

Navigate to the student file location and click Save. 

 The message shown in Figure 1-18 will appear before the portable file is created. Click 

OK to continue. 
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Figure 1-18 Message for creating portable company file 

 QuickBooks displays the QuickBooks Desktop Information dialog box (see Figure 1-19). 

Click OK to return to the working data file.  

  
Figure 1-19 Message that the Portable File has been successfully created 

Restoring Backup Files 

When working with important financial information, creating backup files is a crucial safeguard against 

data loss. Every business should conduct regular backups of company information. QuickBooks has 

useful tools to automate this process. 

In the event of an emergency, you may need to restore lost or damaged data. For example, if your 

computer’s hard drive fails, you can restore your backup onto another computer and continue to work. 

Note: 

Portable files should never be used as a substitute for backup files. Backup files are 

larger than portable files and hold more information about the company.  

Backing Up Your Data File 

Backing up your data is one of the most important safeguards you have to ensure the safety of your 

data, and should be done daily. 

COMPUTER PRACTICE 

 To back up your company file, select Create Copy from the File menu.  
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 Choose Backup copy from the Save Copy or Backup window (see 

 

 Figure 1-20). Click Next.  

 

Figure 1-20 Save Copy or Backup window 

 You are given the option to save the backup to a local storage device, such as a 

removable hard disk or a network folder. There is also an option for online backup 

using a fee-based service available from Intuit. Online backup is a good option for 

many companies who require offsite backups.  

 

Choose Local backup and click Next. 

 The Backup Options window is displayed (see Figure 1-21). Under the Local backup 

only section, click the Browse button.  
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Figure 1-21 Backup Options window 

 Select the folder where you want to store your backup file (see Figure 1-22). You 

should store the backup files in a safe location, preferably on a different drive than 

your working data file. That way, if the drive with the working file is damaged, the 

backup will still be available.  

 
Figure 1-22 Backup options Browse for Folder window 

 When finished, click OK. 

 The Save Copy or Backup window is displayed (see Figure 1-23). You can save a 

backup now, schedule future backups, or both. Select Only schedule future backups 

and click Next. 
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Figure 1-23 Save Copy or Backup window 

 In the Save Copy or Backup window, select New under the Back up on a schedule 

area. 

 
Figure 1-24 Save Copy or Backup window 

 The Schedule Backup window appears (see Figure 1-25). Enter a descriptive name for 

the backup, the location of the folder to contain the backups, and the time when the 

backup file will be created.  
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Figure 1-25 Schedule Backup window 

 When finished, click OK to close the Schedule Backup window.  

 The Store Windows Password window opens. Enter your Windows username and 

password and click OK. 

 Click Finish to close the Schedule Backup window. 

 If necessary, click OK to close the QuickBooks: Backups have been scheduled as 

specified. Window.  

 If necessary, click No, Thanks for the offer to try Online Backup. 

Restoring a Backup File 

COMPUTER PRACTICE 

Follow these steps to restore the QuickBooks backup file you just created: 

 Select the File menu and then choose Open or Restore Company. 

 Choose Restore a backup copy from the Open or Restore Company window and click 

Next. 

 In the Open or Restore Company window you can specify whether the file is stored 

locally or through Intuit’s fee-based Online Backup service. Choose Local backup and 

click Next. 

 The Open Backup Copy window allows you to specify where your backup file is located. 

Navigate to the folder that contains the file, select it and click Open.  

 The Open or Restore Company window displays. Click Next.  

 The Save Company File as window allows you to specify where to restore the working 

files. Navigate to the appropriate folder and click Save. QuickBooks will then restore 

your backup file in the folder you specified. You may be prompted to enter a password. 

When QuickBooks restores the file, it creates a .QBW file. 
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 After completion, a window displays that the new file has been successfully restored 

(see Figure 1-26). 

 
Figure 1-26 After restoring backup file 

Note:  

When you restore a data file, depending on today’s date, you may see one or more 

alerts for learning to process credit cards, pay taxes, or similar activities. Click Mark as 

Done when you see these alerts. 

QuickBooks User Interface Features 

QuickBooks provides a number of shortcuts and tools that assist the user in entering information and 

transactions. You should become familiar with these features so you can get to a task quickly. There 

are various methods of accessing the data entry windows: the Home page, Snapshots, Menus, 

QuickBooks Centers, Icon Bar, and Shortcut Keys. 

Home Page 

As soon as you open a company file, QuickBooks displays the Home page (Figure 1-27). The Home 

page is broken into five sections, each dealing with a separate functional area of a business: Vendors, 

Customers, Employees, Company, and Banking. Each area has icons to facilitate easy access to 

QuickBooks tasks. The Home page also displays a workflow diagram showing the interdependency 

between tasks.  

Tip: 

Click on each of the area’s header buttons to open the corresponding Center. 

 
Figure 1-27 QuickBooks Accountant 2021 Home page—your screen may vary 
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To start a task, just click on its icon on the Home page. If you close the Home page, it can be opened 

by clicking on the Home icon on the Icon bar, or by selecting Home Page from the Company menu.  

Icon Bar 

The QuickBooks Icon Bar allows you to select centers, activities and available services by clicking icons 

on the bar (see Figure 1-28). For example, you can open the Home page by clicking Home on the Icon 

Bar.  

Click the Collapse Arrow at the top of the blue Icon Bar to shrink it, giving you more workspace area.  

The Icon Bar can also be moved to the top of the screen by clicking the View menu. 

 

Figure 1-28 The Icon Bar 

Centers 

QuickBooks Centers summarize pertinent information and transactions in one place. There are several 

Centers for specific tasks. Centers can be opened from the Menus, Home page buttons, and the Icon 

Bar. 

Customer, Vendor, and Employee Centers are very important since they provide the only way to access 

a list of your customers, vendors, and employees. These three lists are referred to as the Center-based 

Lists. For example, when you click on the Customers section label in the Home page, the Customer 

Center opens to show each customer’s balance, their general information, and all their transactions 

(see Figure 1-29).  

 
Figure 1-29 Customer Center 
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Other Centers include the Bank Feeds Center, the Report Center, and the Doc Center. These Centers 

will be addressed later in this book.  

Calendar 

You can view transactions on a Calendar. The calendar displays transactions on the Entered date and 

the Due date.  

Note:  

The Entered date is not the date the transaction is entered into QuickBooks. It is the 

date on each transaction form. If you create an invoice on January 5, 2021 and enter 

the date 1/6/2021 in the date field, the invoice will show on January 6, 2021 on the 

Calendar.  

COMPUTER PRACTICE 

 Click the Calendar icon on the Company section of the Home page. 

 The Calendar window opens (see Figure 1-30). When finished, close the Calendar 

window. 

 
Figure 1-30 QuickBooks Calendar - your screen may vary 

Income Tracker 

 
Figure 1-31 Income Tracker – your screen may vary 

The Income Tracker provides a fast way to see the status of your revenue-based transactions. Click on 

the colored boxes in the Money Bar to filter the list for Estimates, Sales Orders, Unbilled Time & 

Expenses, open and overdue Invoices, and recent Payments.  

Snapshots 

The Snapshots Center is a single-screen summary of different aspects of a company. Charts such as 

Income and Expense Trends, Previous Year Income Comparison, and Expense Breakdown are 

displayed along with important lists such as Account Balances and Customers Who Owe Money. The 
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Snapshots can be easily customized to show the information that is of most interest to you and your 

company. 

 
Figure 1-32 Snapshots - your screen may vary 

Entering Transactions in QuickBooks 

Each time you buy or sell products or services, pay a bill, make a deposit at the bank, or transfer 

money, you enter a corresponding transaction into QuickBooks.  

Each activity should have one action. For example, a customer paying off several invoices will still have 

ONE Receive Payment form for the ONE check they handed you (more about that on page 59).  

Forms 

In QuickBooks, transactions are created by filling out familiar-looking Forms such as invoices, bills, and 

checks. When you finish filling out a form, QuickBooks automatically records the accounting entries 

behind the scenes. Most forms in QuickBooks have drop-down lists to allow you to pick from a list 

instead of spelling out the name of a customer, vendor, item, or account.  

By using forms to enter transactions, you provide QuickBooks with all of the details of each 

transaction. For example, by using the Enter Bills form, QuickBooks tracks the vendor balance, the due 

date of the bill, the discount terms, and the debits and credits in the General Ledger. This is a good 

example of how QuickBooks handles the accounting behind the scenes. 

Before QuickBooks, many bookkeepers used Journal Entries to manually enter accounting 

transactions. Journal entries limit QuickBooks from providing management information beyond just the 

debits and credits. If a form is available that achieves your goal, use it! 

COMPUTER PRACTICE 

 Click the Enter Bills icon in Vendors section of the Home page (see Figure 1-33). 

 
Figure 1-33 Enter Bills on the Home page 

 Click the Previous button in the upper left corner of the Enter Bills window until you see 

the previously entered bill (see Figure 1-34). 

 Click the down arrow next to the vendor field to see the drop-down list for vendors. 
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 Click the Calendar icon next to the date to see the Date Picker.  

 When finished exploring, click the Revert button in the bottom right, which will return 

the transaction to the last saved state.  

 Close the Enter Bills window. 

 

 
Figure 1-34 Anatomy of a Form 

Lists 

Lists are one of the most important building blocks of QuickBooks. Lists store information that is used 

again and again to fill out forms. For example, when you set up a customer, including their name, 

address and other details, QuickBooks can use the information to automatically fill out an invoice. 

Similarly, after an Item is set up, QuickBooks automatically fills in its description, price, and associated 

account information. This helps speed up data entry and reduce errors.  

Note: 

There are two kinds of lists — menu-based and center-based. Menu-based lists are 

accessible through the Lists menu and populate the fields on forms. Center-based lists 

include the Customer Center and Vendor Center, discussed on page 20. 

Lists can be viewed by selecting an icon from the Home page (for example, the Items & Services 

button), choosing an option from the Lists menu, or viewing a list through one of the various 

QuickBooks Centers. 

Accounts 

QuickBooks efficiently tracks all of your business transactions by categorizing them into Accounts in 

your General Ledger. The Chart of Accounts is the list of these accounts.  
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COMPUTER PRACTICE 

 To display the Chart of Accounts, click the Chart of Accounts icon on the Home page. 

Alternatively, you could select Chart of Accounts from the List menu, or press Ctrl+A.  

 Scroll through the list. Leave the Chart of Accounts open for the next exercise. 

 

By default, the Chart of Accounts is sorted alphabetically within each account type (see Figure 1-35). If 

you are using Account Numbers, the categories are sorted by account number. 

Use the Search Box at the top to quickly find the account you need. 

The Name column shows the account names that you assign. The Lightning Bolt indicates Bank Feed 

connectivity. The Type column shows their account type. The Balance Total column shows the 

balances for asset, liability, and equity accounts (except Retained Earnings). The Attach column shows 

if there are attached documents.  

 
Figure 1-35 Chart of Accounts List 

Registers 

Each asset, liability, and equity account (except Retained Earnings) has a Register. Registers allow you 

to view and edit transactions in a single window. Income and expense accounts do not have registers; 

rather, their transactions must be viewed in a report.  

COMPUTER PRACTICE 

 To open the Checking account register, double-click on 10100 Checking in the Chart of 

Accounts list.  

 The Checking register opens (see Figure 1-36). Scroll through the register.  
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Figure 1-36 Checking account register 

 Close the Checking account register by clicking the Close button in the upper right 

corner.  

 Double-click the 40000 Services account. You may need to scroll down. This is an 

Income account.  

 Instead of opening a register, QuickBooks opens a QuickReport (see Figure 1-37). 

 If necessary, change the Dates field to All and click Refresh.  

 Close the report.  

 Close the Chart of Accounts.  

 
Figure 1-37 A QuickReport 

Items 

Items are used to track a company’s services and products. Since every business has its own unique 

set of products and services, QuickBooks needs to be customized by creating items for everything you 

buy and sell. For more detail on items and the different item types, see page 281. 

Items are necessary in order to use sales forms in QuickBooks (e.g., Invoices and Sales Receipts). On 

an invoice, for example, each line has an item representing a product, service, discount, or sales tax.  

When you define items, you associate them with accounts in the Chart of Accounts. This connection 

between item names and accounts is the “magic” that allows QuickBooks to automatically create the 

accounting entries behind each transaction.  
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For example, Figure 1-39 displays the Item List. Take a look at Camera SR32, for example. It is 

associated with a Sales Income account, Inventory Asset, and Cost of Goods Sold in the Chart of 

Accounts. Every time the Camera SR32 item is added to an invoice, the dollar amount increases the 

Sales account in the Chart of Accounts, and moves its original cost from Inventory to Cost of Goods.  

COMPUTER PRACTICE 

 To see what items are available in the file, click the Items & Services icon on the Home 

page in the Company section (see Figure 1-38). Alternatively, you could select Item List 

from the Lists menu.  

 
Figure 1-38 Items & Services button on Home page 

 Figure 1-39 shows the Item List. Double-click the Camera SR32 item. 

 
Figure 1-39 Item List 

 If the New Feature window opens, click OK.  

 The Edit Item window opens (see Figure 1-40). Notice this item is linked to the Sales 

account. Every time this item is entered on an invoice, it adds the purchase price to 

Sales Income.  

 Close the Edit Item and Item List windows.  
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Figure 1-40 Camera SR32 Edit Item window 

QuickBooks Help 

Support Resources 

QuickBooks provides a variety of support resources that assist in using the program. Some of these 

resources are on the Internet and others are stored in Help files locally along with the QuickBooks 

software on your computer. To access the support resources, select the Help menu and then choose 

QuickBooks Desktop Help, or press F1 on your keyboard. QuickBooks will display context-sensitive 

answers to problems you might be having, based on the window you have open. You can also enter a 

question and QuickBooks will search its Help Content and the Online Community for related answers.  

You can also access Support through messaging and call back options. 

Certified QuickBooks ProAdvisors 

Certified QuickBooks ProAdvisors are independent consultants, accountants, bookkeepers, and 

educators who are proficient in QuickBooks, who can offer guidance to small businesses in various 

areas of business accounting. To find a Certified ProAdvisor, select Find a Local QuickBooks Desktop 

Expert from the Help menu. 
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Review Questions 

Comprehension Questions 

1. Explain the difference between a QuickBooks working data file, a QuickBooks backup file and a 

QuickBooks portable file. How can you differentiate between the three types of files on your 

hard disk? 

2. Explain the difference between QuickBooks Desktop and QuickBooks Online. What are the 

different versions of QuickBooks Desktop? 

3. Explain the importance of the QuickBooks Home page. 

4. Explain why it is important to enter transactions in QuickBooks using Forms rather than 

accounting entries. 

5. Describe the primary purpose of accounting in business. 

Multiple Choice 

Select the best answer(s) for each of the following: 

1. The fundamental accounting equation that governs all accounting is: 

a) Net income = Revenue - expenses. 

b) Assets + Liabilities = Equity. 

c) Assets = Liabilities + Equity. 

d) Assets = Liabilities - Equity. 

2. Which of the following statements is true? 

a) Debits are bad because they reduce income. 

b) Equity is increased by a net loss. 

c) Debits = credits. 

d) Assets are increased with a credit entry. 

3. Under accrual accounting: 

a) A sale is not recorded until the customer pays the bill. 

b) Income and expenses are recognized when transactions occur. 

c) An expense is not recorded until you write the check. 

d) You must maintain two separate accounting systems. 

4. QuickBooks is: 

a) A job costing system. 

b) A payroll system. 

c) A double-entry accounting system. 

d) All of the above. 

5. Which is not a method of accessing the data entry screens? 

a) Menus 

b) Home page 

c) Icon bar 

d) Data entry button 
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Completion Statements 

1. As you enter data in familiar-looking ________, QuickBooks handles the __________ entries for 

you.  

2. You should ________ your data file regularly because it is one of the most important 

safeguards you can do to ensure the safety of your data. 

3. When you open your working data file, QuickBooks displays the _____ ______. This screen is 

broken into five sections – each dealing with a separate functional area of a business.  

4. ____________ are used in QuickBooks Sales forms to represent what the company buys and 

sells. 

5. A list which shows all the accounts in your working data file is called the ______ ___ ______. 

Introduction Problem 1 

Restore the Intro-21Problem1.QBM file. The password to access this file is Questiva21. 

1. Select Customers from the QuickBooks Icon Bar. This will display the Customer Center.  

a) What is the first customer listed on the left of the Customer Center?  

Note:  

The answer to this first question is AAA Services. If you don’t see AAA Services in the 

Customer Center, make sure to restore Intro-21Problem1.QBM as directed in the box 

above. This book uses specific files for each chapter and each problem. If you don’t 

restore the correct file, you will have trouble completing the exercises. 

b) In the Customers & Jobs Center, single click on Mason, Bob. What is Bob Mason’s balance?  

c) Click the Date drop down list above Bob’s transaction listing and make sure it says All. How 

many transactions do you see, and of what type? 

d) Close the Customer Center. 

2. From the Home Page, click the Enter Bills icon. The Enter Bills window opens.  

a) Click the Previous button in the upper left corner. What is the name of the vendor displayed 

on this bill? 

b) What is the Bill Due date on this bill?  

3. From the Home page, click the Chart of Accounts icon to display the Chart of Accounts. 

a) What type of account is the Checking Account? 

b) How many total accounts are there of this same type? 

c) What is the Balance Total for the Money Market account? 
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Introduction Problem 2 (Advanced) 

Restore the Intro-21Problem2.QBM file. The password to access this file is Questiva21. 

1. Select Customers from the QuickBooks Icon Bar. This will display the Customer Center.  

a) What is the first customer listed on the left of the Customer Center?  

Note:  

The answer to this first question is ABC International. If you don’t see ABC International 

in the Customer Center, make sure to restore Intro-21Problem2.QBM as directed in the 

box above. This book uses specific files for each chapter and each problem. If you don’t 

restore the correct file, you will have trouble completing the exercises. 

b) In the Customers & Jobs Center, single click on Cruz, Maria. What is Maria Cruz’s balance?  

c) Click the Date drop down list above Bob’s transaction listing and make sure it says All. How 

many transactions do you see, and of what type? 

d) Close the Customer Center. 

2. Select Vendors from the QuickBooks Icon Bar. This displays the Vendor Center.  

a) Double-click Boswell Consulting . This opens the Edit Vendor window. What is their address? 

Close the Edit Vendor window. 

b) Single click on Sinclair Insurance. What is the amount of Bill number 5055 to Sinclair 

Insurance (you may need to set the Date to All as in Step 1)? 

c) Close the Vendor Center. 

3. From the Home page, click the Chart of Accounts icon to display the Chart of Accounts. 

a) What type of account is Payroll Liabilities? 

b) How many accounts of the type Fixed Asset are in the Chart of Accounts? 

c) How many accounts of the type Other Current Asset are in the Chart of Accounts? 

4. While still in the Chart of Accounts, double-click the Checking account on the Chart of Accounts 

list. This will open the register for the Checking account. 

a) Who was the payee for the check on 2/10/2021? 

b) What was the amount of the check? 

c) Close the Checking register and close the Chart of Accounts list. 

5. Click the Create Invoices icon on the Home page, and then click on the Previous arrow (top 

left). 

a) What is the Invoice Number?  

b) Who is the customer listed on this invoice? 

c) What is the first item listed on this invoice?  

d) Close the invoice. 

6. Select the Chart of Accounts option from the Lists menu. Double-click on the Checking 

account. 

a) Which vendor was paid by the last bill payment (BILLPMT) in the register? 

b) What is the Bill Payment Number?  

c) What is the amount of the last bill payment in the register? 

d) Close the Checking register and close the Chart of Accounts list. 
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7. Click the Write Checks icon on the Home page and follow these steps:  

a) Click on the Calendar icon immediately to the right of the Date field. Select tomorrow’s date 

in the Date field and press Tab.  

b) In the Pay to the Order of field, enter Ace Supply. Press Tab. 

c) Enter 80.00 in the Amount field and press Tab. 

d) Check the Print Later check box at the top of the window. 

e) What is the city displayed in the Address field on the check for Ace Supply? 

f) Click Clear and then close the check window.  

8. Select the Chart of Accounts option from the Lists menu and double-click on Accounts 

Receivable. 

a) What is the ending balance in the account? 

b) Who was the customer on the last transaction in the register? 

c) Close the register and close the Chart of Accounts list. 

9. Click the Check Register icon on the Home page. 

a) Select 10100 – Checking from the Use Register dialog box.  

b) What is the ending balance in the checking register? 

c) Close the checking register. 

10. Close the working data file Intro-21Problem2.QBW. 
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Chapter 2  

The Sales Process 

Topics 

In this chapter, you will learn about the following topics: 

• Tracking Company Sales (page 33) 

• Setting Up Customers (page 37) 

• Job Costing (page 43) 

• Recording Sales (page 44) 

• Receiving Payments from Customers (page 56) 

• Making Bank Deposits (page 64) 

• Income Tracker (page 73) 

Restore this File: 

This chapter uses Sales-21.QBW. See page 10 for more information. The password to 

access this file is Questiva21. 

In this chapter, you will learn how QuickBooks can help you record and track revenue in your business. 

Each time you sell products or services, you will record the transaction using one of QuickBooks’ forms. 

When you fill out a QuickBooks Invoice or Sales Receipt, QuickBooks tracks the detail of each sale, 

allowing you to create reports about your income.  

Tracking Company Sales 

Sales are recorded two different ways. When the customer pays at the time of sale or service (called a 

cash customer) use a Sales Receipt. When the customer pays after the sale or service (a credit 

customer) use an Invoice.  

In this case, the terms “cash” and “credit” aren’t referring to the payment methods used; they’re 

referring to the specific workflow needed to track the sale. 

Sales Receipts 

At the time of sale, a Sales Receipt is issued, and then a Deposit is recorded. This process is displayed 

graphically on the Home page (see Figure 2-1). A sales receipt records both the items sold and the 

amount received. Then the funds are deposited into the bank along with the rest of that day’s sales.  

Note: 

Payment with a credit card is received immediately; therefore, a customer who pays at 

the time of sale with a credit card is still a “cash” customer. 
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Figure 2-1 Cash Sale Workflow 

When working with a credit customer, the sales process has a different workflow. Often, the first step is 

to create an Invoice. The Payment is later received and applied to the invoice. Then a Deposit is 

recorded to put the money in the bank (see Figure 2-2).  

 
Figure 2-2 Invoicing Workflow 

Table 2-1 provides more details about the cash and credit customer sales processes. In this table, you 

can see how to record business transactions for cash and credit customers, including the accounting 

behind the scenes of each transaction. As discussed on page 4, the accounting behind the scenes is 

critical to your understanding of how QuickBooks converts the information on forms (invoices, sales 

receipts, etc.) into double-sided accounting entries. 
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Each row in the table represents a business transaction you might enter as you proceed through the 

sales process. 

Business 

Transaction 

Cash Customers  

(Pay at time of sale,  

Sales Receipt) 

Credit Customers  

(Pay after the sale date, 

Invoice) 

QuickBooks 

Transaction 
Accounting Entry 

QuickBooks 

Transaction 
Accounting Entry 

Estimate 

(Optional) 
Not usually used 

 

Non-posting entry 

used to record 

estimates (bids) for 

customers or Jobs 

Sales Order 

(Optional) 
Not usually used 

 

Non-posting entry 

used to record 

customer orders 

Recording a 

Sale 

 

Increase (debit) 

Undeposited Funds, 

increase (credit) 

Income account 
 

Increase (debit) 

Accounts 

Receivable, increase 

(credit) Income 

account 

Receiving 

Money in 

Payment of an 

Invoice 

No additional action is required 

 

Increase (debit) 

Undeposited Funds, 

decrease (credit) 

Accounts Receivable 

Depositing 

Money in the 

Bank 
 

Decrease (credit) 

Undeposited Funds, 

increase (debit) Bank 

account  

Decrease (credit) 

Undeposited Funds, 

increase (debit) 

Bank account 

Table 2-1 Steps in the sales process 

The Sales Receipt form records the details of what you sold to whom, and then holds the pending 

deposit in, by default, a special account called Undeposited Funds. This account is an Other Current 

Asset account. Think of it as the drawer where you keep your checks and cash before depositing them in 

the bank. See page 48 for more information on Undeposited Funds. 

The Accounting Behind the Scenes:  

When you create a Sales Receipt, QuickBooks increases (with a debit) a bank account or 

Undeposited Funds, and increases (with a credit) the appropriate Income account. If 

applicable, Sales Receipts also increase (with a credit) the Sales Tax Liability account. If 

the sale includes an Inventory item, it also decreases (credits) the Inventory Asset and 

increases (debits) the Cost of Goods Sold account. 

Invoices 

For credit customers, the sales process usually starts with creating an Invoice. The invoice form records 

the details of who you sold to and what you sold. 
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The Accounting Behind the Scenes:  

When you create an Invoice, QuickBooks increases (with a debit) Accounts Receivable 

and increases (with a credit) the appropriate Income account. If applicable, invoices also 

increase (with a credit) the Sales Tax Liability account. If the sale includes an Inventory 

item, it also decreases (credits) the Inventory Asset and increases (debits) the Cost of 

Goods Sold account. 

When you receive money from your credit customers, use the Receive Payments form to record the 

receipt. If you have created an invoice for the sale, you must accept payment through this process to 

close the invoice. 

The Accounting Behind the Scenes:  

When you record a received Payment, QuickBooks increases (with a debit) Undeposited 

Funds or a Bank account, and decreases (with a credit) Accounts Receivable. 

Deposits 

Whether you posted to Undeposited Funds through a sales receipt or a payment, the last step in the 

process is always to make a Deposit to your bank account by using the Make Deposits function. This 

step is the same for both cash and credit customers. See page 64 for more information on making bank 

deposits. 

Estimates 

If you prepare Estimates (sometimes called bids) for customers or jobs, you can track the details of what 

the future sale will include. Estimates are provided to customers to help them decide to move forward 

with their purchase of a product or service. Estimates do not post to the General Ledger, but they help 

you track a job from bid to completion. QuickBooks also provides reports that help you compare 

estimated vs. actual revenues and costs.  

The Accounting Behind the Scenes:  

When you create an Estimate, QuickBooks records the estimate, but there is no 

accounting entry made. Estimates are “non-posting” entries, which means they don’t 

show up on your Profit & Loss Statement or Balance Sheet. They are only used to track 

business activity. 

Sales Orders 

Sales Orders are available in QuickBooks Premier, Accountant and Enterprise Solutions. Sales orders 

are similar to estimates because they both help you track future sales, and also do not post to the 

General Ledger.  

Sales orders allow you to track inventory on hold for pending orders by including the product details. For 

example, if you are out of stock on goods needed for a specific customer, you could create a sales order 

to track the customer’s order until it is fulfilled. 

The Accounting Behind the Scenes:  

When you create a Sales Order, QuickBooks records the sales order, but there is no 

accounting entry made. Sales orders are “non-posting” entries.  

In the following sections, you will learn about each step of the workflow at the time of sale for cash and 

credit customers. 
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Setting Up Customers  

For each of your customers, create a record in the Customers & Jobs list of the Customer Center. 

Imagine Photography has a new credit customer – Dr. Tim Feng. To add this new customer, follow these 

steps: 

COMPUTER PRACTICE  

 Select the Customers button from the Icon bar or the Home screen. 

 To add a new customer, select New Customer from the New Customer & Job drop-down 

menu (see Figure 2-3). 

 
Figure 2-3 Adding a new customer record 

 Enter Feng, Tim in the Customer Name field (see Figure 2-4) and then press Tab. 

 Press Tab twice to skip the Opening Balance and As of fields. Since you will not enter an 

amount in the Opening Balance field, there is no need to change the As of date. 

 
Figure 2-4 New Customer window  
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Important Tip:  

It is best NOT to use the Opening Balance field in the customer record. When you enter 

an opening balance for a customer in the Opening Balance field, QuickBooks creates a 

new account in your Chart of Accounts called Uncategorized Income. Then, it creates an 

Invoice that increases (debits) Accounts Receivable and increases (credits) Uncategorized 

Income.  

It is better to enter the actual open invoices for each customer when you set up your 

company file, using their actual date and line items. That way, you will have all of the 

details of which invoices are open, when they occurred, and what items were sold. When 

you use invoices, the proper income accounts will be used instead of Uncategorized 

Income.  

 Because this customer is an individual (i.e., not a company), press Tab to skip the 

Company Name field. 

 Continue entering information in the rest of the fields using the data in Table 2-2. You do 

not need to enter anything in the fields not included below.  

Field Data 

Mr./Mrs. Dr. 

First Name Tim 

M.I. S. 

Last Name Feng 

Job Title Owner 

Main Phone 408-555-8298 

Main Email drf@df.biz 

Invoice/Bill To Address 

 

Hint: Press Enter to move to a 

new line in this field. 

Tim S. Feng 

300 N. First St. 

San Jose, CA 95136 

Ship To Click Copy>>. This displays the Add Shipping Address Information 

window (see Figure 2-5). Type Office in the Address Name field 

and click OK.  

Table 2-2 Data to complete the Address Info tab 

 
Figure 2-5 Add Ship To Address Information window 
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Figure 2-6 shows the finished Address Info tab of the customer record. Verify that your screen matches. 

Note: 

In QuickBooks, you can use multiple Ship-To Addresses. This is useful when one 

customer requests that products be sent to more than one address.  

 
Figure 2-6 Completed Address Info tab 

Tip:  

There are four name lists in QuickBooks: Vendor, Customer:Job, Employee, and Other 

Names. After you enter a name in the Customer Name field of the New Customer window, 

you cannot use that name in any of the other three lists in QuickBooks.  

When Customers are also Vendors:  

When you sell to and purchase from the same company, you’ll need to create two 

records, one in the Vendor list and one in the Customer:Job list. Make the two names 

slightly different. For example, you could include a middle initial or “Inc.” after the 

company name in the Vendor list. Another strategy is to enter Feng, Tim-c in the New 

Customer window and Feng, Tim-v in the New Vendor window.  

The vendor and customer records for Tim Feng can contain the same contact information; 

it’s just the name that needs to be different. 

 Click the Payment Settings tab on the left of the New Customer window to continue 

entering information about this customer as shown in Figure 2-7. 

 Enter 3546 in the Account No. field to assign a customer number by which you can sort 

or filter reports. Press Tab.  

 Enter 8,000.00 in the Credit Limit field and press Tab. 

 

Credit Limits provide an accounts receivable ceiling for the customer to reduce risk. 

QuickBooks will warn you if you record an invoice to this customer when the balance due 

(plus the current sale) exceeds the credit limit. Even though QuickBooks warns you, 

you’ll still be able to record the invoice. 
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 Select Net 30 from the Payment Terms drop-down list as the terms for this customer 

and then press Tab.  

 

QuickBooks is terms smart. For example, if you enter terms of 2% 10 Net 30 and a 

customer pays within 10 days, QuickBooks will automatically calculate a 2% discount. 

For more information about setting up your Terms list, see page 264. 

 Select Commercial from the Price Level drop-down list. See page 266 for information on 

setting up and using price levels. Press Tab twice. 

 Leave the default setting of Email in the Preferred Delivery Method field. 

 

You can use Preferred Delivery Method if you plan to email invoices to a customer on a 

regular basis or if you plan to use QuickBooks Payments Merchant Services.  

Note:  

QuickBooks Payments Merchant Services allows customers to pay you with credit cards 

and ACH bank transfer, right inside QuickBooks. For more information, select the Help 

menu and then choose Add QuickBooks Services. You will then be directed online to the 

Intuit website. Click on the Learn More button under the Get Paid Faster section. 

Transaction fees apply.  

 Select Visa from the Preferred Payment Method drop-down list and then press Tab.  

When you set the fields on this window, you are storing the credit card number securely 

for future use. You won’t have to re-enter the credit card information each time you 

receive money from the customer. 

If you are using QuickBooks Payments Merchant Services, you will be able to charge the 

card directly inside QuickBooks. 

Tip:  

If more than one person accesses your QuickBooks file, set up a separate username and 

password for each additional user. When you set up a user, you can restrict him or her 

from accessing Sensitive Accounting Activities like customer credit card numbers. See 

page 482 for more information about setting up usernames and passwords. 

 Enter the remaining data as shown in Figure 2-7 in the Credit Card Information section. 

Some of the fields will auto-populate as you tab into those fields. You may overwrite the 

auto-populated values if needed. 

 If you use QuickBooks Payments, use the Online Payments box to specify whether they 

will be able to pay you by Credit Card, Bank Transfer (ACH), or both when you send them 

an invoice by email  
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Figure 2-7 The Customer Payment Settings window 

 Click the Sales Tax Settings tab in the New Customer window (see Figure 2-8). 

 Press Tab twice to accept the default Sales Tax Code in the Tax Code field. 

 

Sales Tax Codes serve two purposes. First, they determine the default taxable status of 

a customer, item, or sale. Second, they are used to identify the type of tax exemption. 

For complete information on sales tax codes, see page 98. 

 Set the Tax Item field to Santa Clara. This indicates which sales tax rate to charge and 

which agency collects the tax. Press Tab when finished. 

Tip: 

In most states, you charge sales tax based on the delivery point of the shipment. 

Therefore, the Sales Tax Item should be chosen to match the tax charged in the county 

(or tax location) of the Ship To address on the Address Info tab. 

 Leave the Resale No. field blank. 

 

If the customer is a reseller, you would enter his or her tax-exempt Resale Number. 

 
Figure 2-8 Completed Sales Tax Settings tab 
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 Select the Additional Info tab in the New Customer window (see Figure 2-9). 

 Select Business from the Customer Type drop-down list and then press Tab. 

 

QuickBooks allows you to group your customers into common types. By grouping your 

customers into types, you’ll be able to create reports that focus on one or more types. 

For example, if you create two types of customers, Residential and Business, you are 

able to tag each customer with a type. Then you can create reports, statements, or 

mailing labels for all customers of a certain type. 

 Select MM for Mike Mazuki in the Rep drop-down list and then press Tab.  

 

Use this field to assign a Sales Rep (one of your employees or vendors) to this customer. 

If you use the Rep field, you can create reports (e.g., Sales by Rep report) that provide 

the sales information you need to pay commissions or track productivity. Even if you 

assign a default sales rep to a customer, each sales form (invoice or sales receipt) can 

still have a different name or initials in the Rep field. 

 Enter Santa Clara in the County field. 

 

The Define Fields button on the Additional Info tab allows you to define Custom Fields to 

track more information about your customers. For more information on setting up and 

using custom fields, see page 268. 

 
Figure 2-9 Completed Additional Info tab 

 Select the Job Info tab. You can use this tab to track the status of your engagement with 

the customer. 

Note:  

If you track multiple jobs for each customer, it is best NOT to enter job information on the 

Job Info tab of the main customer record. If you want to track jobs for this customer, you 

can create separate job records in the Customers & Jobs list. 

 Click OK to save and close the New Customer window. 

Note: 

If you see an error message when saving the Feng, Tim customer (see Figure 2-10), you 

may not be in the correct exercise file. Make sure you restore the correct file at the start 

of each chapter and problem, otherwise your exercises may not match the activities in 

this book. For this chapter, you should be using Sales-21.QBW. For instructions on 

restoring portable files, please see page 10. 



The Sales Process   43 

 The Sales Process 

 
Figure 2-10 Error Message when saving a Name that already exists 

 Close the Customer Center by clicking the close button or by pressing the Esc key. 

Job Costing 

Each customer listed in the Customer Center can have one or more jobs. A Job is a project you do for the 

customer. Setting up jobs underneath the customers helps group income and expenses by project, and 

therefore create reports showing detailed or summarized information about each one. This is particularly 

important for some industries, such as construction. 

To create a job for an existing customer record, open the Customer Center, select the Customer, and 

then choose Add Job from the New Customer & Job drop down menu. You don’t need to do this now, 

because the sample data file already has jobs set up. 

  
Figure 2-11 Adding a Job to an existing customer record 

Key Term:  

Tracking income and expenses separately for each job is known as Job Costing. If your 

company needs to track job costs, make sure you include the job name on each income 

and expense transaction as these transactions are created. Job costing reports such as a 

Profit & Loss by Job provide useful insights into your business. 

In the Name column of the Customers & Jobs list, jobs are slightly indented under the customer name. 

  
Figure 2-12 Customers & Jobs list 
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Did You Know? 

To Quick Add a job for a customer on an invoice or sales receipt, enter the customer’s 

name followed by a colon (the customer name must already exist in the Customer List 

first). After the colon, enter the name of the job. QuickBooks will then prompt you to 

either Quick Add or Set Up the job.  

If the customer record already includes job information on its Job Info tab, you won’t be 

able to use Quick Add to create a job for the customer. In this case, you will need to 

create the job in the Customers & Jobs list before you begin entering sales. 

Recording Sales  

Now that you’ve set up your customers, you’re ready to begin entering sales. We will look at the Sales 

Receipts form first. Use this form when you receive a cash, check, or credit card payment at the time of 

the sale or service. We will also look at the Invoice, the other way to enter sales when you record credit 

sales to customers. 

Entering Sales Receipts 

When customers pay at the time of the sale by cash, check, or credit card, create a Sales Receipt 

transaction. 

COMPUTER PRACTICE 

 Click the Create Sales Receipts icon in the Customers section on the Home page (see 

Figure 2-13). This opens the Enter Sales Receipts window (see Figure 2-14). 

  
Figure 2-13 Selecting Create Sales Receipts icon on the Home page 

 Enter Perez, Jerry in the Customer:Job field and press Tab.  

 
Figure 2-14 Sales Receipt form 

 When the Customer:Job Not Found warning window appears (see Figure 2-15), click 

Quick Add to add this new customer to the Customer:Job list. If you choose this option, 

you can edit the customer record later to add more details. 
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Quick Add works on all your lists. Whenever you type a new name into any field on any 

form, QuickBooks prompts you to Quick Add, Set Up, or Cancel the name. 

 
Figure 2-15 Use Quick Add to add new customers 

Tip:  

If your customer is an individual (i.e., not a business), it’s a good idea to enter the 

customer’s last name first. This way, your Customer:Job list sorts by last name so it will be 

easier to find names in the list. 

Note: 

Many forms display Customer Summary information in the History Pane on the right side 

of the form, which includes two tabs – one for Customer (also called Name) information 

and the other for Transaction information. Jerry Perez is a new customer and therefore 

does not have any information or history to display. 

 Enter San Jose in the Class field and then press Tab. 

 

QuickBooks uses Classes to separately track income and expenses for departments, 

functions, activities, locations, or profit centers. For more information on classes, see 

page 124. Note that if the class has already been set up, it will appear in that field as 

you type it or in the drop-down menu. 

 In the Template field, Custom Sales Receipt is already selected. Press Tab.  

 

You can create your own custom form layouts, as you’ll learn in the section beginning on 

page 270. 

 Click on Check for payment method, then press Tab.  

 

If you wanted to add a new payment method, you would click on the More button. 

 Enter 1/27/2021 in the Date field and then press Tab (see Figure 2-16). 

Did You Know? 

Whenever you enter a date in QuickBooks, you can use any of several shortcut keys to 

quickly change the date. For example, if you want to change the date to the first day of 

the year, press y. “Y” is the first letter of the word “year,” so it’s easy to remember this 

shortcut. The same works for the end of the year. Press r since that’s the last letter of the 

word “year.”  

The same works for “month” (m and h) and “week” (w and k). You can also use the + and 

- keys to move the date one day forward or back. All of these shortcuts are relative to the 

date already entered in the date field. Finally, press t for “today” or the system date. See 

the Keyboard Shortcut list in the Appendix on page 585. 
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 Enter 2021-1 in the Sale No. field.  

 

The first time you enter a sales receipt, enter any number you want in the Sale No. field. 

QuickBooks will automatically number future sales receipts incrementally. You can 

change or reset the numbering at any time by overriding the Sale No.. 

 Press Tab to skip the Sold To field. 

 

QuickBooks automatically fills in this field, using the address information in the 

Invoice/Bill To field of the customer record. Since you used Quick Add to add this 

customer, there is no address information. You could enter an address in the Sold To 

field by entering it directly on the sales form. When you record the sales receipt, 

QuickBooks will give you the option of adding the address in the Invoice/Bill To field of 

the customer record.  

 Enter 3459 in the Check No. field and then press Tab.  

 

The number you enter here shows up on your printed deposit slips. If you were receiving 

a cash or credit card payment, you would leave this field blank. 

 Select Outdoor Photo Session from the Item drop-down list and then press Tab. 

 Press Tab to accept the default description Outdoor Photo Session in the Description 

column. 

 

As soon as you enter an item, QuickBooks enters the description, rate, and sales tax 

code using data from the item that has already been set up. 

 In the Tax column, the SRV sales tax code is already selected. Press Tab. 

 Enter 3 in the Qty. (quantity) column and then press Tab. 

 Leave the default rate at 95.00 in the Rate column and then press Tab. 

 Press Tab to accept the calculated amount in the Amount column. 

 

After you enter the rate and press Tab, QuickBooks calculates the amount by multiplying 

the quantity by the rate. If you override the Amount field, QuickBooks calculates a new 

rate by dividing the amount by the quantity. 

 Select Premium Photo Package from the Item drop-down list and then press Tab.  

 Enter 2 in the Qty. column and press Tab. 

 Press Tab to accept the default rate of 85.00. 

 

You can override this amount directly on the sales receipt if necessary. As with the line 

above, QuickBooks calculates the total in the Amount column and QuickBooks uses the 

default sales tax code Tax, which is set up for the Premium Photo Package item.  

 Select Thank you for your business. from the Customer Message drop-down list.  

 

You can enter a message in the Customer Message field that will show on the printed 

sales receipt. This is typically a thank you message, but it can be whatever you want. If 

you type in a new message, Quick Add will prompt you to add your new message to the 

Customer Message list to use again in the future. If you want to edit an existing 

customer message, or to remove one from the list, click the Lists menu, select Customer 

& Vendor Profile Lists, and then choose Customer Message List. 
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 Press Tab and enter Santa Clara in the Tax field, then Tab again to advance to the 

Memo field.  

 

The Sales Tax item shown in the Tax field determines the rate of tax to be charged on all 

taxable items shown on the form. Each line in the body of the invoice is marked with a 

Sales Tax Code that determines the taxability or non-taxability of the item on that line 

(see Figure 2-16). 

 Enter Outdoor Session, 2 Premium Packages in the Memo field.  

 Click Save & Close to record the sale.  

 

QuickBooks does not record any of the information on any form until you save the 

transaction by clicking Save, Save & Close, Save & New, Previous, or Next. 

 

 
Figure 2-16 Completed Sales Receipt 

Note: 

If you prefer to use your keyboard over a mouse, you can use the Alt key in combination 

with other keys to execute commands. QuickBooks will tell you which key can be used in 

connection with the Alt key by underlining the letter in the command. For example, in the 

Sales Receipt window, the S is underlined on the Save & New button. You can save the 

receipt and move to a new Sales Receipt window by pressing the Alt key with the S.  

 QuickBooks displays the Information Changed dialog box (see Figure 2-17). This dialog 

box appears because you added the Class and Tax Item fields after creating the 

Customer using Quick Add. Click the Yes button. 

 
Figure 2-17 Information Changed dialog box 
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Undeposited Funds 

The Undeposited Funds account is a special account that is automatically created by QuickBooks. The 

account works as a temporary holding account where QuickBooks tracks monies received from 

customers before the money is deposited into a bank account. It’s the equivalent of the blue envelope 

businesses traditionally used back in the day, to hold cash and checks while driving them to the bank. 

As illustrated in Figure 2-18, when you record payments and sales receipts, QuickBooks gives you a 

choice between (Option 1) grouping all receipts into the Undeposited Funds account, or (Option 2) 

immediately depositing the funds to one of your Bank accounts.  
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Figure 2-18 All funds from sales transactions go through Undeposited Funds or directly to a bank account. 

There is a tradeoff here. When you use the Undeposited Funds account, you have to create a separate 

transaction (an additional step) to actually deposit money into a bank account. At first that might seem 

like extra work. However, when you skip the Undeposited Funds account, each sales transaction creates 

a separate deposit in your bank account.  

Since it is most common to have multiple sales transactions deposited together, using Undeposited 

Funds gives you an opportunity to batch credit cards, or collect cash and checks together, so that the 

deposit total in the bank register matches the bank’s activity.  

QuickBooks has a default preference setting that makes all payments and sales receipts increase the 

balance in the Undeposited Funds account. Then when you actually make a deposit at the bank, you 

record a single deposit transaction in QuickBooks that empties the Undeposited Funds account into the 

bank account. This method makes it much easier to reconcile the bank account at the end of each 

month because the deposits on the bank statement will match the deposits in your QuickBooks bank 

account. Unless you only make one sale each day and your deposits include only the funds from that 

single sale, you will want to keep this default preference. 

COMPUTER PRACTICE 

You can modify the Undeposited Funds preference by following these steps: 

 Select the Edit menu and then choose Preferences. 

 Select Payments on the left side of the Preferences window. 

 In the Company Preferences tab, the box next to Use Undeposited Funds as a default 

deposit to account is checked (see Figure 2-19).  
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Did You Know? 

Entering the spacebar on the keyboard when a checkbox is selected will either check or 

uncheck that checkbox.  

 If you prefer to deposit payments individually, uncheck the box next to Use Undeposited 

Funds as a default deposit to account. You will then have the option to select an account 

to deposit to in each sales receipt and payment window. 

 Click Cancel to leave default setting for the use of Undeposited Funds. 

 
Figure 2-19 Preference for Payments to go to Undeposited Funds or another account 

When this preference is off, QuickBooks displays the Deposit To field on the Receive Payments and 

Enter Sales Receipt windows (see Figure 2-20).  

  
You must choose a destination account for the transaction from the Deposit to drop-down list. 

 
Figure 2-20 The Deposit To field shows on Sales Receipts when the Undeposited Funds preference is off. 
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Creating Invoices 

Invoices are very similar to Sales Receipts. The only difference is that invoices increase Accounts 

Receivable while sales receipts increase Undeposited Funds (or the specified bank account). Use 

invoices to record sales to your customers who are not paying in full immediately, instead buying on 

credit. 

COMPUTER PRACTICE 

To create an Invoice, follow these steps: 

 From the Customer Center select Mason, Bob from the Customers & Jobs list. Then 

select Invoices from the New Transactions drop-down list.  

 

Alternatively, click the Create Invoices icon on the Home page and select Mason, Bob 

from the Customer:Job drop-down list. Press Tab (see Figure 2-21).  

Did You Know?  

When you type characters into a field populated by a list, QuickBooks completes the field 

using a feature called QuickFill. QuickFill searches the list for the characters you type to 

find the names that contain those letters. You don’t have to start with the first letters in 

the name; choosing unique letter combinations will suggest the shortest list of choices. 

 

 
Figure 2-21 Invoice after Customer:Job field selected, before remaining data entered. 

 Notice that Bob Mason has two open invoices listed in the History Pane.  

 

The History Pane displays recent transactions and notes about a customer or a 

transaction on invoices and sales receipts. 

 Click the Hide button to hide the History Pane. The Hide button is a right-facing triangle 

on the top left edge of the History Pane (see Figure 2-21). 
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 Click in the Class field. Enter an s. QuickBooks will QuickFill the field with the full name 

San Jose. Then press Tab. 

 In the Template field, select Imagine Photo Service Invoice. Press Tab. 

 Enter 1/27/2021 in the Date field and then press Tab.  

 Enter 2021-106 in the Invoice # field and then press Tab. 

 

The first time you enter an invoice, enter any number you want in the Invoice # field. 

QuickBooks will automatically number future invoices incrementally. You can change or 

reset the numbering at any time by overriding the number on a future invoice. 

 Press Tab to accept the default information in the Bill To field.  

 

QuickBooks automatically enters the address in this field, using the information in the 

Invoice/Bill To field from the customer record. If necessary, change the Bill To address 

by typing over the existing data.  

 Leave the P.O. Number field blank and then press Tab. 

 

The P.O. (purchase order) number helps the customer identify your invoice. When your 

customers use Purchase Orders, make sure you enter their P.O. numbers on invoices 

you create for them. 

Warning:  

Make sure you enter the P.O. number if your customer uses purchase orders. Some 

customers may reject invoices that do not reference a P.O. number. 

 In the Terms field, 2% 10 Net 30 is already selected. Press Tab to proceed to the next 

field. 

 

The Terms field on the invoice indicates the due date for the invoice and how long your 

customer can take to pay you. The entry in this field determines how this invoice is 

reported on Customers & Receivables reports such as the A/R Aging Summary and the 

Collections Report. To learn more about the Terms list, see page 264. 

 Enter the sale of 1 Indoor Photo Session and 1 Standard Photo Package into the body of 

the invoice as shown in Figure 2-22. 

 Select Thank you for your business from the Customer Message drop-down list and then 

press Tab. 

 Santa Clara in the Tax field is already selected. Press Tab.  

 

As with sales receipts, QuickBooks selects the Sales Tax Item based on the defaults in 

Sales Tax Preferences or in the customer’s record. 

 Enter 1 Hr Indoor Session, 1 Standard Package in the Memo field at the bottom of the 

form. 

Tip:  

When you intend to send statements to your customers, the Memo field is important. 

While QuickBooks does show line item detail on your customer’s invoices, if you want 

them to be more concise, you can choose not to show the line item detail and to show the 

text from the Memo field instead. Therefore, it may be useful to include information about 

the products or services you sold to the customer in the Memo field.  
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 Compare your screen with the invoice shown in Figure 2-22. If you see any errors, 

correct them. Otherwise, click Save & Close to record the invoice. 

 
Figure 2-22 Completed Invoice 

QuickBooks automatically tracks all of the accounting details behind this transaction so that your reports 

will immediately reflect the sale. For example, the Open Invoices report, the Profit & Loss Standard 

report, and the Balance Sheet Standard report will all change when you record this invoice. 

Adding Calculating Items to an Invoice 
On the next invoice, you’ll learn how to include Discounts and Subtotals on an invoice. Discounts and 

subtotals are called Calculating Items.  

Key Term:  

Calculating Items use the amount of the preceding line to calculate their amount. For 

example, if you enter 10% in the Discount item setup window and then enter the Discount 

item on an invoice, QuickBooks will multiply the line just above the Discount item by 10% 

and enter that number, as a negative, in the Amount column. 

COMPUTER PRACTICE 

To create an invoice with a calculating item, follow these steps: 

 From the Customer Center’s Customers & Jobs list, select the Anderson Wedding 

Planners job for Wilson, Sarah and Michael.  

 Select Invoices from the New Transactions drop-down list or, press Ctrl+ I. 

 The Wilson, Sarah and Michael job for Anderson Wedding Planners is already selected. 

Press Tab. 

 Enter San Jose in the Class field and then press Tab. 

 The Imagine Photo Service Invoice template in the Template drop-down list is already 

selected. Press Tab. 

 1/27/2021 is already entered in the Date field. Press Tab. 
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 Notice the Invoice # is automatically entered for you with the next invoice number (i.e., 

2021-107). Press Tab to skip to the next field. 

 Press Tab to skip the Bill To field. 

 Press Tab twice to skip the P.O. No. and the Terms fields. 

 Enter the two items shown in Table 2-3 in the body of the invoice. 

Item Qty Description Rate Amount 

Camera SR32 3 Supra Digital 

Camera SR32 

695.99 2,087.97 

Lens 1 Supra Zoom 

Lens 

324.99 324.99 

Table 2-3 Data for use in the Invoice 

 On the third line of the body of the invoice, in the Item column, enter Subtotal to sum the 

previous two item lines, and press Tab twice. 

 

Notice that QuickBooks automatically calculates the sum of the first two lines on the 

invoice. 

 Enter Disc 10% in the Item column and press Tab. 

 

The Disc 10% item is a special calculating item that calculates a percentage of the 

preceding line on sales forms. Since it is a Discount Item, QuickBooks performs the 

calculation and enters a negative amount for your discount. This subtracts the discount 

from the total of the invoice and adjusts sales tax accordingly. 

Did You Know? 

Shortcuts can help you save time when entering items on forms. Right-click on almost 

anything in a form for contextual commands. You can also use keyboard commands to 

copy, paste, insert or delete lines on an invoice (or any other form). To copy a line, put 

your cursor in the line you wish to copy and press Ctrl+Alt+Y (or select the Edit menu, and 

then choose Copy Line). To Paste, put your cursor in the line you wish to paste and press 

Ctrl+Alt+V (or select the Edit menu, and then choose Paste Line). To insert a line between 

two existing lines, click on the line that you want to move down and press Ctrl+Insert (or 

select the Edit menu, and then choose Insert Line). To delete a line, click on the line you 

want to delete and press Ctrl+Delete (or select the Edit menu, and then choose Delete 

Line). 

 Leave the Customer Message field blank. 

 Leave Santa Clara in the Tax field. Also leave Tax in the Customer Tax Code field. 

 Enter 3 Cameras, Lens in the Memo field. 

 Verify that your screen matches Figure 2-23.  

 To save the invoice, click Save in the Main tab at the top of the invoice. We will leave this 

invoice open for the next exercise. 
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Figure 2-23 Completed Invoice with discount  

 If you see the Recording Transaction warning about Anderson Wedding Planners 

exceeding their credit limit (see Figure 2-24), click Yes. 

 

Figure 2-24 Recording Transaction window warns you about the customer’s credit limit 

DON’T PERFORM THESE STEPS RIGHT NOW. THEY ARE FOR REFERENCE ONLY. 

Adding Attachments to Invoices 
It’s important to maintain a paper trail, the documentation behind your transactions. You can add 

attachments to invoices, as well as expenses and most transaction types throughout QuickBooks.  

When you have Word documents, Excel spreadsheet, pdfs, or images that you would like to associate 

with an invoice, click the Attach File paperclip in the center of the toolbar. An Attachments window opens 

(see Figure 2-25). 
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Figure 2-25 Add Attachments to any QuickBooks Form 

Drag-and-drop any file saved on your computer into the box. Alternatively, click the Computer button to 

find a file by browsing, or the Scanner button to use a scanner. The Doc Center button accesses 

QuickBooks’s Doc Center if you are using that feature. 

When you email an invoice and want to include the attachment, choose Invoice and Attached Files from 

the dropdown arrow under the Email button (see Figure 2-26). The preview of the email will show the 

attachment so you can confirm that you have the correct documentation. 

 

Figure 2-26 Email an Invoice with Attachments 

Open Invoices Report 

Now that you’ve entered invoices for your customers, QuickBooks’ reports include the invoices and their 

status. The Open Invoices report is shown in Figure 2-28.  

COMPUTER PRACTICE 

 Select the Reports tab at the top of the invoice, and click on View Open Invoices icon, as 

shown in Figure 2-27. Or, alternatively, select the Reports menu, select Customers & 

Receivables, and then choose Open Invoices.  

 
Figure 2-27 View Reports Tab 

 Set the Dates field at the top of the report to 1/31/2021 and then press Tab. 

 Verify that your Open Invoices report matches Figure 2-28. 
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Figure 2-28 Open Invoices report 

 Close the report by clicking the X in the upper right corner of the window. 

 If you see a Memorize Report dialog box, click the No button (see Figure 2-29). We’ll look 

at Memorized Reports later on page 242. 

 
Figure 2-29 Memorize Reports window 

 Click Save & Close to close the invoice. 

 Close the Customer Center. 

Did You Know? 

You can adjust any column on the report to make it wider or narrower. Click on the three 

small dots between the column headers, and drag to the left or to the right. 

Receiving Payments from Customers 

Receiving Payments by Check 

To record payments received from your customers and apply the payments to specific invoices, follow 

these steps: 

COMPUTER PRACTICE  

 Click Receive Payments on the Home page. 
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 Select Mason, Bob in the Received From field of the Receive Payments window (see 

Figure 2-30). Once a customer is selected, the Customer Payment window shows the 

open invoices for that specific customer. This section shows the dates of the invoices, 

along with the invoice number, original amount, the last date for the prompt payment 

discount, and the amount due. 

 
Figure 2-30 Receive Payments window 

 Enter 401.39 in the Payment Amount field and then press Tab (see Figure 2-31). 

 Enter 1/28/2021 in the Date field and then press Tab. 

 Select Check as Pmt. Method and then press Tab. 

 Enter 5256 in the Check # field and then press Tab. 

 Confirm that Invoice #3947 is already checked. 

 Verify that the Amount Due and Payment columns for the selected invoice both show 

$401.39.  

 

The checkmark to the left of the Date column indicates the invoice to which QuickBooks 

will apply the payment. QuickBooks automatically selected this invoice because the 

amount of the customer’s check is the same as the unpaid amount of the invoice. If 

applicable, you can deselect the invoice by clicking on the checkmark and instead select 

another invoice from the list (see page 60). 

 Enter Payment Received - Invoice #3947 in the Memo field and then press Tab. 

 

When entering a memo, type Payment Received followed by the invoice number. Memos 

do not affect the application of payments to specific invoices, but they are helpful in two 

very important ways. First, if you send your customers statements, only the information 

in the Check #, Date, and Memo fields will show on statements, along with a three-letter 

code (PMT), representing the payment transaction. Also, if you ever have to go back to 

the transaction and verify that you’ve applied the payment to the correct invoice(s), you’ll 

be able to look at the Memo field to see the invoice(s) to which you should have applied 

the payments. 

 Verify that your screen matches Figure 2-31. If you see errors, correct them. 
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 Click Save & Close to record the payment. 

 

 
Figure 2-31 Completed Receive Payments window 

Handling Partial Payments 

In the last example, Bob Mason paid Invoice #3947 in full. However, if a customer pays only a portion of 

an invoice, you should record the payment just as you did in the last example, except that the amount 

would be less than the full amount due on any of the open invoices.  

Apply the partial payment to the appropriate invoice. QuickBooks shows the option to either leave the 

invoice open or write off the unpaid amount. If you need to contact the customer to ask a question about 

the partial payment, click the View Customer Contact Information button. QuickBooks will display the 

Edit Customer window with the customer’s contact information (see Figure 2-32). 

 
Figure 2-32 Partial Payment of Invoice 

If you chose to leave the underpayment, the next time you use the Receive Payments function for that 

customer, the invoice will indicate the remaining amount due. You can record additional payments to the 

invoice in the same way as before. 
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Handling Payments Against Multiple Invoices 

You can apply one payment from a customer to multiple invoices. When a customer pays more than one 

invoice by check or credit card, check off the appropriate invoices in the Receive Payments window so 

that the total adds up to the payment amount.  

You can also override the amounts in the Payment column to apply the total to invoices in whatever 

combination is necessary.  

If you do not allocate the entire payment, QuickBooks will give you a choice to either hold the remaining 

balance as a Credit for the customer or Refund the balance to the customer. 

A common mistake is to break a single payment into multiple payments to apply to multiple invoices. 

Each real-life action should have one corresponding QuickBooks transaction. 

Receiving Payments by Credit Card 

The next example shows that Maria Cruz paid off the invoices owed on the Branch Opening job using a 

credit card. You can receive credit card payments right in QuickBooks using QuickBooks Payments, or 

record payments received through other merchant services. 

COMPUTER PRACTICE 

 From the Customer Center select the Cruz, Maria:Branch Opening job from the 

Customers & Jobs list. Select Receive Payments from the New Transactions drop-down 

list.  

 Enter data into the Amount, and Date fields as shown in Figure 2-34. 

 Select the Credit Debit button as payment method. The Enter Card Information window 

opens (see Figure 2-33). 

 Enter Visa in the Payment field. 

 Enter 1234-1234-1234-1234 in the Card Number field. QuickBooks masks all but the 

last 4 digits of the credit card number with x’s for security purposes. 

 Enter 10/2021 as Exp Date as shown in (see Figure 2-33). Click Done when finished. 

 
Figure 2-33 Credit Card Information 

 Leave the Reference# field blank. Press Tab. 

 Enter Payment Received - 3 Invoices in the Memo field.  

 Verify that your screen matches Figure 2-34 and click Save & Close.  
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.  

Figure 2-34 Customer Payment by Credit Card  

Note:  

If you want to save a customer’s credit card information for future payments, enter the 

credit card information into the Payment Settings tab of the customer or job record 

before you process the payment through the Receive Payments window. When you enter 

the customer or job name, QuickBooks will enter the credit card information 

automatically. 

Where Do the Payments Go? 

Recall the earlier discussion about Undeposited Funds beginning on page 48. Unless you turned off the 

Undeposited Funds as a default deposit to account preference, QuickBooks does not increase your bank 

balance when you receive payments. Instead, when you record a payment transaction as shown above, 

QuickBooks reduces the balance in Accounts Receivable and increases the balance in Undeposited 

Funds. In order to have your payments show up in your bank account (and reduce Undeposited Funds), 

you must Make Deposits. See the section called Making Bank Deposits beginning on page 64. 

The Accounting Behind the Scenes:  

Payments increase (debit) Undeposited Funds (or a bank/other current asset account) 

and decrease (credit) Accounts Receivable.  

Preferences for Applying Payments  

As soon as you enter the customer name at the top of the Receive Payments window and press Tab, 

QuickBooks displays all of the open invoices for that customer in the lower section of the window (see 

Figure 2-35). 

  
Figure 2-35 Payment automatically applied to the oldest Invoice 
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Then, when you enter the payment amount, QuickBooks looks at all of the open invoices for that 

customer. If it finds an amount due on an open invoice that is the exact amount of the payment, it 

matches the payment with that invoice. If there is no such match, it applies the payment to the oldest 

invoice first and continues applying to the next oldest until the payment is completely applied. If this 

auto application of payments results in a partially paid invoice, QuickBooks holds the balance on that 

invoice open for the unpaid amount. This is a feature called Automatically Apply Payments.  

If you select an invoice in the Receive Payments form before entering an amount, QuickBooks calculates 

the sum of the selected invoice(s) and enters that sum into the Payment Amount field. This feature is 

called Automatically Calculate Payments. 

COMPUTER PRACTICE 

To modify the Automatically Apply Payments and Automatically Calculate Payments settings, change the 

Company Preferences for Payments.  

 Select the Edit menu and then choose Preferences. 

 Select the Payments icon from the preference category in the list on the left. Then click 

the Company Preferences tab (see Figure 2-36). 

 Check or uncheck the Automatically apply payments box to change it. For now, leave it 

checked.  

 

With this feature disabled, in the Receive Payments window you will have to click Auto 

Apply Payment for each payment you process, or you will have to manually apply 

payments to invoices by clicking in the column to the left of the invoice and modifying 

the amount in the Payment column as necessary. 

 You can change the Automatically calculate payments box by checking or unchecking it. 

For now, leave it checked. 

 

When this preference is on, QuickBooks will automatically calculate the payment 

received from the customer in the Amount field of the Receive Payments window as you 

select the invoices. When this preference is off, QuickBooks does not automatically 

calculate payments. 

 Click OK. 

  
Figure 2-36 Payments Company Preferences  
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Recording Customer Discounts 

What if your customer takes advantage of the discount you offer on your invoice? In the next example, 

the payment you receive is less than the face amount of the invoice because the customer took 

advantage of the 2% 10 Net 30 discount terms that Imagine Photography offers. 

COMPUTER PRACTICE 

Follow these steps to record a payment on which the customer took a discount: 

 From the Customer Center select Mason, Bob from the Customers & Jobs list. Then 

select Receive Payments from the New Transactions drop-down list.  

 Enter all the customer payment information as shown in Figure 2-37. The customer is 

paying for Invoice #2021-106 after taking the discount allowed by the terms. 

 
Figure 2-37 Top portion of the Receive Payments window 

 The bottom portion of the Receive Payments window displays the open invoices for this 

customer (see Figure 2-38). The Disc. Date column shows the date through which the 

customer is eligible to take a discount. If the customer is eligible for discounts, a 

message may appear just below the open invoices.  

 

If the amount paid is not an exact match with any invoice balance, QuickBooks 

automatically applies the payment to the oldest invoices. Here, Invoice #2021-104 is 

automatically selected since the amount $151.45 does not match any open invoices. 

The underpayment is also displayed. We’ll fix this in the next step. 

 
Figure 2-38 Bottom portion shows discount and credit information box, Invoice selected and Underpayment 

In the Receive Payments window the Underpayment amount is displayed with options to Leave this as 

an underpayment or Write off the extra amount. These options are displayed when the payment is less 

than the amount due on the selected invoices. Similarly, Overpayment amounts are displayed with 

options to Leave the credit to be used later or Refund the amount to the customer when the payment is 

more than the amount due on the selected invoices. 

 Click in the column to the left of Invoice #2021-104 to uncheck it and then click to 

check Invoice #2021-106 (see Figure 2-39). This moves the payment so that it now 

applies to Invoice #2021-106. Make sure to uncheck #2021-104 before checking 

#2021-106, or you will see a Warning message. 
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Figure 2-39 Payment is now applied to the correct Invoice 

 Since the customer took advantage of the 2% 10 Net 30 terms that Imagine 

Photography offered him, you’ll need to reduce the amount due by 2%. To apply the 

discount to this invoice, click the Discounts and Credits button at the top of the Receive 

Payments window.  

 QuickBooks calculates and enters a suggested discount based on the terms on the 

customer’s invoice as shown in Figure 2-40. You can override this amount if necessary. 

Press Tab. 

  
Figure 2-40 Discounts and Credits window 

 Select 46000 Sales Discounts in the Discount Account field. Press Tab. 

 

The Discount Account field is where you assign an account that tracks the discounts you 

give to your customers. 

 Enter San Jose in the Discount Class field and then click Done. 

 

Since Imagine Photography uses class tracking, you will need to enter the appropriate 

class in this field. If you do not classify this transaction, QuickBooks will display the 
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amount in an Unclassified column on the Profit & Loss by Class report. Refer to the 

invoice you are discounting to determine the class. Imagine Photography used the San 

Jose class when recording Invoice 2021-106. 

 

After recording the discount, the Receive Payments window reflects Total Discount and 

Credits Applied at the bottom. 

 
Figure 2-41 Receive Payments window after (recording the discount) 

 Verify that your screen matches Figure 2-41.  

 Click Save & Close to record the transaction. 

 Close the Customer Center. 

 

What if the Payment Doesn’t Match the Invoice? 

If the customer’s payment amount doesn’t exactly equal the invoice, you’ll need to make a choice. Do 

you want to leave a remaining balance or credit and follow up, or would you rather just close the invoice 

and finish the sale?  

If the payment amount is significantly different, apply the amount of the payment and then send the 

invoice back to the customer showing the balance due (if the payment is too low), send a Refund to the 

customer (if the payment is too high), or leave the balance as a Credit Memo to apply to their next 

invoice. You may wish to send a Statement to the customer showing the history of the activity (see page 

95). 

If the amount isn’t worth bringing to your customer’s attention and you choose to just finish the 

transaction, you’ll adjust the invoice so that the payment exactly matches the balance. If the payment is 

too high, enter the amount in the Discounts and Credits window. If the payment is too low, add a new 

line item to increase the total on the sale, and note in the Description that there was an overpayment.  

 

Making Bank Deposits 

You will receive payments from your customers in several different ways: cash, checks, and credit cards. 

Merchant service processors batch all the day’s credit card payments together into one bank deposit. A 

business owner drives an envelope of cash and checks to the bank.  
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Because daily transactions of each payment type are grouped together by the bank, you will also record 

deposits of each type separately in QuickBooks. Creating deposits in QuickBooks mirrors traditional 

deposit slips, making bank reconciliations much easier.  

As you record payments from customers using the Enter Sales Receipts and Receive Payments 

windows, they are posted by default to a special QuickBooks account called Undeposited Funds. To 

move these transactions into your bank account, you will record Deposit transactions. As you will see in 

this section, QuickBooks uses a Payments to Deposit window to help you identify which payments are 

included on each bank deposit.  

You will make several deposits each day. Start with your checks and cash, followed by VISA and 

MasterCard receipts. Deposits into multiple bank accounts are created individually. Because different 

merchant service companies batch their transactions in a variety of ways, American Express receipts 

may require a separate deposit, or you may need to batch credit cards across dates.  

If service fees are deducted from the deposit, like those charged by PayPal and Square, they are 

subtracted during this workflow. 

As you become familiar with your banks’ processes, you will learn the best practices for your scenario. 

Depositing Checks and Cash 

COMPUTER PRACTICE 

When you take a trip to the bank, follow these steps: 

 A red number on the Record Deposits Icon on the Home page indicates that you have 

payments pending in Undeposited Funds (see Figure 2-42). From the Home page select 

Record Deposits.  

 
Figure 2-42 Record Deposits Icon on the Home page showing the number of pending deposits 

 Since you have payments waiting in Undeposited Funds, QuickBooks displays the 

Payments to Deposit window (see Figure 2-43). 

  
Figure 2-43 Select the payments to deposit 

 Select Cash and Check from the View payment method type drop-down list (see Figure 

2-44).  
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Since the checks and cash you deposit in your bank account will post to your account 

separately from credit card receipts, it is best to filter the report by payment type and 

then create a separate deposit for each payment type. Most merchant services combine 

MasterCard and VISA receipts when they credit your bank account. 

Tip:  

Since you can filter the Payments to Deposit window by type, this allows you to filter for 

typically combined payment methods. You may want to create a single payment method 

for MasterCard, and VISA as well.  

To edit Payment Methods, select the Lists menu, then Customer & Vendor Profile Lists, 

and choose Payment Method List. Select the payment method and select Edit Payment 

Method from the Payment Method menu. Payment methods of the same type will be 

grouped together in the Payments to Deposit window. 

  
Figure 2-44 Cash and Check payments 

 The Payments to Deposit window now only shows payments received through Cash and 

Check (see Figure 2-45). Click Select All to select all of the cash and check deposits. 

Click OK. 

A checkmark in the column on the left indicates that QuickBooks will include the 

payment in the deposit. 

 
Figure 2-45 Select the payments to deposit 
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 In the Make Deposits window, the Checking account is already selected in the Deposit 

To field (see Figure 2-46). Confirm that this is the correct bank account for these 

payments. Press Tab. 

 
Figure 2-46 Make Deposits window 

 Enter 1/31/2021 if it does not already display in the Date field and press Tab. 

 Enter Deposit Checks in the Memo field and press Tab. 

Adding Additional Funds to the Deposit 

 On this deposit, we will also add a non-sales-related item. Occasionally, you will have 

deposits that are not from sales transactions in QuickBooks, and these can be entered 

directly in the Make Deposits window. Complete the following steps: 

a) On the first blank line, enter Owner Contribution in the From Account column and 

press Tab. The From Account column on the Make Deposits window shows the 

account that the deposit is coming “from”.  

b) Enter Owner Contribution to Company in the Memo column and press Tab. 

c) Enter 13451 in the Chk No. column and press Tab. 

d) Enter Check in the Pmt Meth. column and press Tab. 

e) Press Tab to skip the Class column. 

f) Enter 15,000.00 in the Amount column. 

 If you wish to print the deposit slip, click Print on the Make Deposits window.  

 Click Save & Close to record the deposit.  
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The Accounting Behind the Scenes:  

In the deposit transaction (Figure 2-46), the Checking account will increase (with a debit) 

by the total Deposit ($16,021.87). The customer checks will decrease (credit) the 

balance in Undeposited Funds, and the contribution from the owner will increase (credit) 

the balance in the Owner Contributions equity account. 

Holding Cash Back from Deposits 
If you hold back cash when you make your bank deposits, fill in the bottom part of the deposit slip 

indicating the account to which you want to post the cash (see Figure 2-47). 

 
Figure 2-47 The bottom of the deposit slip deals with cash back 

There are two ways you might use the cash back section of the deposit:  

1. If you routinely hold back cash from your deposits and use it as cash on hand, set up a new 

QuickBooks bank account called Petty Cash and enter that account in the Cash back goes to 

field. While the petty cash account is not a true bank account, it should be associated with a 

cash box or envelope. Be sure to gather receipts for all cash expenditures and reconcile petty 

cash monthly (see page 146). 

2. If the owner is keeping back cash for their own use, enter their Owners Draw account. In the 

Cash back memo, enter the owner’s name. Enter the amount of the cash being withheld into 

Cash back amount. For more information about Owners Equity, see page 545. 

When you’re done, the total in the Make Deposits window should equal the amount of money being 

deposited in the bank. 

Tip:  

It’s not a good idea to routinely hold cash back from deposits as “pocket money.” If the 

business is a Sole Proprietorship or LLC, it’s better to write a check to the owner (or make 

a bank transfer) and code it to Owners Draw. This is a much cleaner way to track the 

money taken out for personal use. Discuss this with your QuickBooks ProAdvisor, or with 

your accountant. 

Printing Deposit Slips 
QuickBooks can print Deposit Slips on preprinted deposit slips or blank paper. Follow these steps: 

COMPUTER PRACTICE 

 Display the most recent deposit transaction by selecting the Banking menu and then 

choosing Make Deposits.  

 

Click Cancel if you see the Payments to Deposit window. Then click the Previous button 

on the Make Deposits window. Alternatively, you could double-click the deposit 

transaction from the checking account register window. 

 Click Print on the Make Deposits window (see Figure 2-48). 

 Select Deposit slip and deposit summary in the window shown in Figure 2-49 and click 

OK. 
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Normally, you would load the preprinted deposit slips into the printer before printing. 

However, if you do not have a deposit slip, print the deposit on blank paper. 

  
Figure 2-48 Printing a deposit 

 
Figure 2-49 Print Deposit window for deposit slips 

 Check the settings on the Print Deposit Slips window shown in Figure 2-50.  

 
Figure 2-50 Settings on the Print Deposit Slips window 

 Select your printer in the Printer name field.  

 Click Print to print the deposit slip (see Figure 2-51).  

 Click Save & Close to save the deposit. 
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Figure 2-51 Deposit slip and deposit summary 

Depositing Credit Card Payments 

As mentioned previously, to ensure that your bank reconciliations go smoothly, you should always 

deposit your checks and cash separately from your credit card payments. 

Make sure you group transactions together in a way that matches the actual deposits made to your 

bank. Some merchant service companies batch payments during your business hours, so that nighttime 

sales get grouped with the following day. Confirming these totals is a critical step in making your bank 

reconciliation process go smoothly. 

QuickBooks Payments 
One of the benefits of using QuickBooks Payments, Intuit’s built-in merchant services, is its automation 

when matching payments to deposits.  

While we can’t view this in our sample file, on the Customers menu there’s an option for Credit Card 

Processing Activities. Its Record Merchant Service Deposits window shows the status of your merchant 

service payments, including when you can expect each deposit and which transactions make up each 

batch (see Figure 2-52). 

Merchant service fees are deducted in a separate expense transaction, so your bank deposits work the 

same way as depositing cash and checks, as shown on page 65. 
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Figure 2-52 The QuickBooks Payment merchant services deposit status window 

PayPal and Square 
Some merchant services providers (like PayPal or Square) deduct their fees from each transaction. The 

steps to subtract merchant service fees from the deposit are included below. If your merchant services 

provider deducts fees in a separate daily or monthly transaction, skip these steps and add the fees as a 

separate expense as they occur. 

COMPUTER PRACTICE 

 Select the Banking menu, and then choose Make Deposits. The Payments to Deposit 

window opens. 

 Select MasterCard, Visa, Discover from the View payment method type drop-down list 

(see Figure 2-53). 

 Click in the left column on the line to select the payment to deposit. Then click OK. The 

Make Deposits window opens. 

 
Figure 2-53 Payments to Deposit window 

 The Checking account is already selected in the Deposit To field. Press Tab.  

 Enter 1/31/2021 if it is not already entered in the Date field. Press Tab.  

 Enter Deposit Visa in the Memo field.  

Note:  

If your credit card processing company does not deduct their fees from each deposit, skip 

Steps 7-13. 

 On the first blank line of the deposit slip, enter Merchant Service Fees in the From 

Account column and then press Tab. 
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 Enter Merchant Service Fee in the Memo column and then press Tab. 

 Press Tab to skip the Chk No. column. 

 Enter Visa in the Pmt Meth. column and then press Tab. 

 Enter Walnut Creek in the Class column and then press Tab. 

 You can use the QuickMath feature to calculate the merchant service fee directly in the 

Make Deposits window. Enter 1950.00 * -.02 in the Amount column and press Enter.  

QuickMath is a built-in calculator to add, subtract, multiply, or divide in any QuickBooks Amount or 

Quantity field. When you enter the first number (1950.00), it shows normally in the Amount column. 

Then when you enter the * (asterisk key or Shift+8), QuickMath shows a small adding machine tape on 

your screen (see Figure 2-54). Continue typing your formula for recording the discount fee. Since the 

fee is 2%, enter -.02 (minus point zero two) and press Enter. The result of the calculation shows in the 

Amount column (-39.00). The minus sign makes the result a negative number and reduces the amount 

of your deposit. This also increases (debits) your Merchant Service Fees expense account. 

 Press Tab to have the total of the deposit updated automatically. 

 
Figure 2-54 QuickMath makes an adding machine tape appear 

 Verify that your screen matches Figure 2-55. Click Save & Close. 

  
Figure 2-55 Make Deposits window after a credit card deposit 

Viewing Deposits in the Register 

Now that you have entered your deposits, the checking account register shows each one and the 

updated balance in the account.  
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COMPUTER PRACTICE 

To see the detail of a deposit, follow these steps: 

 Click the Chart of Accounts icon on the Home page.  

 Double-click on the Checking account in the Chart of Accounts window. 

 Scroll up until you see the two deposit transactions shown in Figure 2-56. 

 Close the Checking register and the Chart of Accounts. 

 
Figure 2-56 Checking register after entering deposits 

Running Accounts Receivable Reports 

Using the Income Tracker 

The Income Tracker provides you with a fast way to see the status of your unpaid sales transactions all 

from one location. It also provides features to improve invoicing and collections, as well as create new 

sales transactions. You can access the Income Tracker from the Icon Bar, the Customer Center (see 

Figure 2-57), or from the Customers Menu. 

  
Figure 2-57 Income Tracker icon in Customer Center 

The colored bar across the top is called the Money Bar. 

From the Income Tracker you can: 

• See all of your Unbilled (blue boxes) and Unpaid (yellow and red) sales transactions 

• Filter for just one category by clicking on the colored box, or using the filter drop-downs  

• Right-click on any sales transaction to view or edit that transaction  

• Use the Action drop-down to print or send a sales transaction by email 

• Use the Action drop-down to convert an estimate or sales order into an invoice 

• Sort the list by clicking on any column heading  

• Use the Batch Action button to print or email a group of sales transactions all at once  

• Click Manage Transactions to create new customer transactions 
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Figure 2-58 Income Tracker. Your screen may vary. 

COMPUTER PRACTICE 

To use the Income Tracker to process a transaction: 

 Click the Income Tracker icon on the Icon Bar (Figure 2-59). 

  
Figure 2-59 Income Tracker on Icon Bar 

 Check Miranda’s Corner on the left side of the Income Tracker. 

 Click on the drop-down arrow in the Action column for Miranda’s Corner, and choose 

Receive Payment. 

  
Figure 2-60 Receive Payment in Income Tracker. Your screen may vary. 

 Receive Payment for $1,191.80. Verify that your screen matches Figure 2-61. 
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Figure 2-61 Payment from Miranda’s Corner 

 Click Save & Close to record the transaction. 

 Close the Income Tracker. 

Viewing the Invoice History 

To track activity on an invoice, open it up and click the See History link. The Invoice History window 

includes a Status workflow and a detailed History.  

The Status Bar lets you know where the invoice is in its lifecycle. Green checkmarks appear when the 

invoice has been Sent, when it was Viewed by the customer in their email, if they paid it electronically or 

you marked it as Paid, and when the money has been Deposited from Undeposited Funds (see Figure 

2-62). 

The History provides the date of these activities and the specific actions taken. 

 

Figure 2-62 Invoice History 

The Accounts Receivable Aging Summary 

It’s essential to keep track of whether your customers are paying promptly, and if any accounts are 

delinquent. The A/R Aging Summary report lists each customer with a balance, and how long their 

account has been overdue. 
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COMPUTER PRACTICE 

 From the Reports menu, select Customers & Receivables and then choose A/R Aging 

Summary (see Figure 2-63). 

 Change the Dates range to All. 

 

The Current column contains all the current month’s invoices. The remaining columns refer to the 

number of days after the terms assigned to each invoice. A Net 30 invoice will move to the 1-30 column 

on the 31st day. Invoices with the term Due on Receipt will immediately move into the second column if 

left unpaid. 

The Intervals can be adjusted for longer time frames or shorter breakdowns. 

Negative numbers represent customer credits. 

 
Figure 2-63 The A/R Aging Summary Report 

Review Questions 

Comprehension Questions 

1. When you make a sale to a customer who pays at the time of the sale, either by check or by 

credit card, which type of form should you use in QuickBooks to record the transaction? 

2. Explain how the Undeposited Funds account works and why it is best to use the option Use 

Undeposited Funds as a default deposit to account as a Payments preference? 

3. How does the Automatically Apply Payments feature work?  

4. QuickBooks allows you to attach documents to invoices and expenses. Why would you do this? 

What file types can you attach? 

Multiple Choice 

Select the best answer(s) for each of the following: 

1. In the New Customer window, you find everything except: 

a) Customer Name. 

b) Customer Invoice/Bill To and Ship To address. 

c) Customer active/inactive status. 

d) Year-to-date sales information. 
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2. You should record a Sales Receipt when the customer pays: 

a) By cash, check, or credit card at the time of sale. 

b) By cash, check, or credit card at the end of the month. 

c) Sales tax on the purchase. 

d) For the order upon receipt of invoice. 

3. Which statement is false? 

a) Invoices are very similar to the Sales Receipt form. 

b) Invoices decrease Accounts Receivable. 

c) Sales Receipts have no effect on Accounts Receivables. 

d) Invoices should be created when customers are going to pay after the date of the initial sale. 

4. You may specify payment Terms on the New Customer window; however: 

a) The payment Terms will only show on sales receipt transactions. 

b) The Terms can only be changed once a year. 

c) The sales representative must be informed. 

d) You are also permitted to override the Terms on each sale. 

5. Your company has just accepted a payment for an invoice. What should you do in QuickBooks to 

record this payment? 

a) Open the invoice by clicking the Invoices icon on the Home page.  

b) Create a sales receipt by clicking the Sales Receipt icon on the Home page. 

c) Make a deposit by clicking the Record Deposits icon on the Home page. 

d) Receive the payment by clicking the Receive Payments icon on the Home page.  

6. Which statement is false? 

a) Many customers reject invoices that do not reference a P.O. (purchase order) number. 

b) The P.O. number helps the customer identify your invoice. 

c) The P.O. number is required on all invoices. 

d) The P.O. number is generated by the customer’s accounting system. 

7. To record a deposit in QuickBooks: 

a) Make a separate deposit that includes both Checks and Cash receipts. 

b) Make a separate deposit that includes both VISA and MasterCard receipts. 

c) Make sure each deposit total matches the bank feed or bank statement. 

d) All of the above. 

8. Your company has just received an order from a customer who will pay within 30 days. How 

should you record this transaction in QuickBooks? 

a) Create an invoice by clicking the Create Invoices button on the Home page.  

b) Create a sales receipt by clicking the Sales Receipt button on the Home page. 

c) Make a deposit by clicking the Record Deposits button on the Home page. 

d) Receive the payment by clicking the Receive Payment button on the Home page.  

9. When you make a deposit, all of the following are true except:  

a) You must print a deposit slip in order to process a deposit. 

b) A “Make Deposit” transaction typically transfers money from Undeposited Funds into your 

bank account. 

c) You should separate your deposits by payment type. 

d) You should create deposits so that they match exactly with the deposits on your bank 

statement. 
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10. Which statement is true regarding Calculating Items? 

a) Calculating Items cannot be used on invoices because the total is calculated automatically. 

b) A Calculating Item always calculates the amount of all the lines above it.  

c) It is best to avoid using Calculating Items to apply a discount. 

d) A Calculating Item uses the amount of the preceding line to calculate its amount. 

11. When creating a customer record, which statement is false? 

a) After you enter a name in the Customer Name field of the New Customer window, you cannot 

use that name in any of the other name lists in QuickBooks. 

b) The credit limit can be added in the new customer window. 

c) A sales rep must be selected when creating a new customer. 

d) When you sell to and purchase from the same company, you should create two records, one 

in the Vendor list, and one in the Customer:Job list. 

12. When receiving payments from customers to whom you have sent invoices, you must: 

a) Receive the payment in full. Partial payments cannot be accepted in QuickBooks. 

b) Enter them directly into the checking account register. 

c) Enter the payment into the receive payments window and check off the appropriate invoice(s) 

to which the payment applies. 

d) Delete the invoice so it does not show on the customer’s open records. 

13. You need to calculate the amount of a bankcard fee by multiplying the amount of the received 

payments by -1%. What useful QuickBooks feature could you use? 

a) Calculating Items. 

b) QuickMath. 

c) Quick Add. 

d) The Fees button on the bottom of the Make Deposit window. 

14. The Undeposited Funds account tracks: 

a) Bad debts. 

b) Funds that have been received but not deposited. 

c) Funds that have not been received or deposited. 

d) All company sales from the point an invoice is created until it is deposited in the bank. 

15. After entering an existing customer in the Customer:Job field of an invoice, a Customer:Job Not 

Found dialog box opens to say the customer is not on the Customer List. What should you do? 

a) Click the Quick Add button to add the customer to the Customer List.  

b) Click the Set Up button to enter the customer’s information in a New Customer window.  

c) Click Cancel to check the name you entered in the Customer:Job field for typos or other 

errors. 

d) None of the above. 

Completion Statements 

1. A new customer can be added to the customer list without opening the New Customer window 

by clicking _____ ______ after entering a new customer name on a sales form.  

2. When you create a sales receipt, QuickBooks increases (with a debit) a(n) ________ account or 

the _________ _________ account. 

3. Discounts and Subtotals are called ________ Items. 

4. Receiving payments reduces the balance in ________ __________ and increases the balance in 

the Undeposited Funds or a bank account. 

5.  __________________helps you add, subtract, multiply or divide numbers in an Amount field.  
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Sales Problem 1 

Restore the Sales-21Problem1.QBM file. The password to access this file is Questiva21. 

1. Enter your own name and address information into the Customer Center. Then print the 

Customer List by selecting the Reports menu, List, and then Customer Contact List. 

2. Enter a Sales Receipt using the data in Table 2-4. The payment will be automatically grouped 

with other payments in Undeposited Funds account. You’ll need to create the customer record 

using Quick Add, or by setting it up in the list before adding the sale. Print the sale on blank 

paper.  

Field Data 

Customer Name Pavlovich, Anna 

Class Walnut Creek 

Date 1/24/2021 

Sale No. 2021-1 

Sold To Anna Pavlovich 

512 SW Chestnut St.  

Walnut Creek, CA 94599 

Check No 211 

Payment Method Check 

Item Camera SR32, Qty 4 

Sales Tax Contra Costa (8.25%) – Auto Calculates 

Customer Tax Code Tax 

Memo 4 Cameras 

Table 2-4 Use this data for a Sales Receipt in Step 2 

3. Enter an invoice using the data in Table 2-5. Print the invoice on blank paper.  

Field Data 

Customer Name Berry, Ron 

Class Walnut Creek 

Custom Template Imagine Photo Service Invoice 

Date 1/26/2021 

Invoice # 2021-106 

Bill To Ron Berry 

345 Cherry Lane 

Walnut Creek, CA 94599 

PO No. 842-5028 

Terms Net 30 

Item Indoor Photo Session, Qty 3, $95/hour (SRV tax code) 

Item Retouching, Qty 4 (hrs), $95/hour (SRV tax code) 

Sales Tax Contra Costa (8.25%) – Auto Calculates 

Memo 3 Hour Session, 4 Hours Retouching 

Table 2-5 Use this data for an Invoice in Step 3 
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4. Record a payment dated 2/5/2021 for the full amount from Ron Berry (check #9951123) and 

apply it to Invoice 2021-106.  

5. Deposit everything from the Undeposited Funds account into the Checking account on 

2/8/2021. Print Deposit Slip and Deposit Summary onto blank paper. 

Sales Problem 2 (Advanced) 

APPLYING YOUR KNOWLEDGE 

Restore the Sales-21Problem2.QBM file. The password to access this file is Questiva21. 

1. Enter a Sales Receipt using the data in Table 2-6. The payment will be automatically grouped 

with other payments in Undeposited Funds account. You’ll need to create the customer record 

using Quick Add or by setting it up in the Customer Center before adding the sale. Print the sale 

on blank paper.  

Field Data 

Customer Name Pinto, Felix 

Class Walnut Creek 

Date 1/29/2021 

Sale No. 2021-1 

Sold To Felix Pinto 

877 N. Judge St. 

Walnut Creek, CA 94599 

Check No 642 

Payment Method Check 

Item Camera SR32, Qty 3, $695.99 

Item Lens, Qty 3, $324.99 

Sales Tax Contra Costa (8.25%) – Auto Calculates 

Customer Tax Code Tax 

Memo Cameras, Lenses 

Table 2-6 Use this data for a Sales Receipt in Step 1 
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2. Enter an invoice using the data in Table 2-7. Print the invoice on blank paper.  

Field Data 

Customer Name Pelligrini, George: 1254 Wilkes Rd. 

Class San Jose 

Custom Template Imagine Photo Service Invoice 

Date 1/30/2021 

Invoice # 2021-106 

Bill To Pelligrini Builders 

222 Santana Ave. 

Los Gatos, CA 94482 

PO No. 8324 

Terms Net 30 

Item Indoor Photo Session, Qty 4, $95/hour (SRV tax code) 

Item Retouching, Qty 4(hrs), $95/hour (SRV tax code) 

Sales Tax Santa Clara (8.25%) – Auto Calculates 

Memo 4 Hour Session, 4 Hours Retouching 

Table 2-7 Use this data for an Invoice in Step 2 

3. Enter a second invoice using the data in Table 2-8. Print the invoice on blank paper. You will 

need to add this customer either through Quick Add or entering the customer information in the 

Customer Center.  

Field Data 

Customer Name Masood, Jameel 

Class San Jose 

Custom Template Imagine Photo Service Invoice 

Date 1/31/2021 

Invoice # 2021-107 

Bill To Jameel Masood 

339 Walnut St. 

Santa Clara, CA 95111 

PO Number 75224 

Terms 2% 10 Net 30 

Item Indoor Photo Session, Qty 3, $95/hour (SRV tax code) 

Sales Tax Santa Clara (8.25%) – Auto Calculates 

Memo 3 Hour Session 

Table 2-8 Use this data for an Invoice in Step 3 

4. Record a payment dated 2/15/2021 for the full amount from Jameel Masood (check #5342) 

and apply it to Invoice 2021-107.  

5. On 2/15/2021, you received a partial payment from George Pelligrini for the 1254 Wilkes Rd. 

job for $350. Visa payment on card #4321-4321-4321-4321, expires in 5/2024.  

6. On 2/15/2021, deposit everything from the Undeposited Funds account using the following: 
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a) Deposit Cash and Check payments together (Memo: Deposit Checks) to create a $3600.63 

deposit. Print the Deposit Slip and Deposit Summary onto blank paper. 

b) Deposit Visa payments separately (Memo: Visa Fees). Record a 2% merchant services fee 

(use QuickMath to calculate) on the credit card deposit. Use the following data: Account - 

Merchant Service Fees, Payment Method - Visa, Memo-2% Merchant Service Fee. This 

amount should be a negative number. The deposit total should be $343. Print Deposit 

Summary Only onto blank paper. 

 


